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Introduction

The Dialog Command Language Pocket Guide provides a brief summary of the
most common Dialog commands and features encountered by users of:

Dialog Classic

DialogClassic Web™

DialogWeb (Command Interface)

Dialog Toolkit Custom Search Form Tool
DialogLink

Dialog API

The Pocket Guide is intended to serve as a quick-reference resource. For more
extensive explanations and examples of Dialog commands, consult the detailed
help pages online at library.dialog.com/success. For tools to learn how to use
Dialog, refer to the Training Center at support.dialog.com/training. There you will
find details on class offerings, online courses, special events, and tutorials.

Dialog offers a variety of products and services for knowledge workers. The
Dialog Command Language interface (“Dialog Classic”) was developed to meet
the needs of professional researchers and includes many sophisticated tools for
retrieving, manipulating, analyzing, and formatting data from Dialog databases.
Other interfaces for mining and delivering Dialog content are available, ones that
do not use Dialog Command Language. DialogSelect, Dialogl, and DialogPRO
are examples of interfaces that offer familiar fill-in-the-blanks, Web-based forms.
Learn more information about these end-user interfaces, and other Dialog products
and services, online at support.dialog.com/products, or by contacting Dialog via
telephone or e-mail.

How to Use this Guide

The arrangement of topics in the Pocket Guide is by sequence of likely usage.
Basic search commands (BEGIN, SELECT, etc.) are followed by options for
search precision (indexing features, limits, etc.). Special commands and features,
such as SORT and RANK, are covered next. Output options and information
delivery services are presented in separate sections, as are the online finding tools.
The next section is devoted to customization options (SET/SHOW and creating an
account PROFILE), followed by a description of resources for getting additional
help. The recent introduction of DialogLink 5, free communication software
developed by Dialog, augments Dialog Classic with several new commands and
features, including Chemical Structure Searching and powerful new report
formatting options.

All descriptions of commands and features are for Dialog Command Language.
Only essential information is provided. Consult the online help text of the Dialog




Introduction

product you are using, or the comprehensive Dialog Command Language
Reference Guide for more details. Some commands work differently on
DialogWeb and DialogLink than on Dialog Classic. Details relating specifically to
DialogWeb are noted with the symbol i; those relating specifically to DialogLink
5 are noted with the symbol €.

Contacting Dialog

Your feedback is valuable to us. Let us know how we can improve this guide or
any of our services to you by contacting your account representative or the Dialog
Knowledge Center. Thomson Dialog operates out of 47 countries across the globe.
To contact the office nearest you, consult the list at www.dialog.com/contacts.

Telephone 1 800 334 2564 within North America
00 800 33 34 25 64 outside North America
1919 468 9890 (Fax)

E-mail dialogcustomer@thomson.com




Basic Search Commands

Entering Commands/Command Prompt

Commands are used to activate most of the search and output functions of the
Dialog system. Commands are entered in at the system prompt, a question mark:
“?”. The question mark prompt will not display while a previously entered

command is executing.

& The command prompt for DialogWeb appears as a fill-in-the-blank box.

Command I

& commands are entered in the Type-Ahead Buffer when using DialogLink software.

Frequently Used Commands

Command Example Function
(& abbreviation)
BEGIN BEGIN 10 Connects to specified database(s) or
B 50,53 OneSearch/DIALINDEX category. A new
B NURSING BEGIN command erases all previous sets.
B FIRST, 47,148
BEGIN n BEGIN PAPERSCA | Allows you to restrict your search to only
CURRENT CURRENT the most current information available.
CURRENT is especially useful when
searching large archival or fulltext files.
See page 10 for more about CURRENT.
ADD n ADD 9 Use the ADD command to add one or
ADD 9,16,93,148 more files to an in-process session. At any
ADD ASIACO, 52 point in a search, enter ADD followed by
one or more file numbers (or category
names). The new files will be added
immediately to your search. Continue
searching with no change to sets created
prior to your ADD command, or use
REPEAT to update existing sets with
records from the added database(s).
REPEAT REPEAT Use the REPEAT command, after using
the ADD command, to automatically
regenerate your previous sets to include
records from the newly added databases
without re-entering the search strategy.
FIND F QUEEN Retrieves the same results as SELECT
F ELIZABETH QUEEN(W)ELIZABETH.
Must include proximity operator to search
F EAST(1W)EDEN stop word to retrieve EAST OF EDEN.
& FIND is not available in DialogLink 5.




Basic Commands

Command Example Function
(& abbreviation)
SELECT SELECT JURY Creates a set of records that contains the
S S AU=WOLFE, V? specified term(s). Can be used with
S CABLE/TI,DE words, prefix, or suffix codes, E numbers,
S S3 and DANCE or set numbers. Multiple terms can be
S S12/2005 entered with logical or proximity
S S1:54 operators. When SELECT is used, only a
SE3ES5 single set number is assigned. Each search
statement may be approximately 2,000
characters in length.
SELECT STEPS | SS LOUISIANA Creates a set for each search term or each
SS (2N)FLOOD? single E number, as well as a final set of
SS SONY(W)DVD records that contain the specified terms.
SS E3:E5 or E12
COMBINE C1AND2 May be used in place of SELECT when
C10R2 combining set numbers and logical
operators only. The “s” before the set
number may be omitted. No search terms
or proximity operators may be entered
C1AND(30R4) using COMBINE. No spaces are required
in the command statement.
DISPLAY SETS DS Displays a list of all sets formed since the
DS DS S10:512 last BEGIN command. A range of sets
can be specified.
EXPAND EXPAND ART Displays the portion of the database index
E E AU=LOPEZ, A in which the term appears. Can be used
E CO=MICROSOFT | with words or prefix codes and with E
E (ART THERAPY) numbers for databases with an online
EE4 thesaurus. Enter PAGE (or P) to view
next screen of EXPAND display; enter
PAGE- or (P-) for previous screen. In
Dialog Classic, 12 entries from the index
are displayed.
& @ EXPAND in DialogWeb and
DialogLink 5 displays 50 index entries at
one time. DialogLink 5 also offers the
VISUAL EXPAND (VE) Command, a
graphical version of EXPAND.
HELP Online help is available at any time
? during your session by using the HELP
HELP SELECT or ?SELECT command followed by the topic. For

example, HELP PRINT displays a
message explaining the use of the PRINT
command.
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Command Example
(& abbreviation)
PAUSE Suspends your search session for up to 10

minutes. The session resumes as soon as
you enter any data. If you exceed the 10-
minute window, you are logged off, and
PAUSE defaults to LOGOFF HOLD.

& pPAUSE is not available in DialogLink
5

LOGOFF Disconnects you from Dialog and
Also: DISC, LOG, LOGOUT, OFF, BYE, displays a cost estimate.
QUIT, or STOP (the HOLD option can also | &¥ €% | OGOFF is also a click-button

be used, e.g., LOG HOLD). option on the menu bar of DialogWeb and
DialogLink 5.

LOGOFF HOLD LOGOFF HOLD disconnects you, but

Note: When reconnecting after a LOGOFF | also holds your existing sets for 30

HOLD, use DS to display current sets. minutes to allow you to reconnect and

BEGIN will erase current sets. continue your search.

&3 @ continue your DialogWeb or
DialogLink 5 session after entering
LOGOFF HOLD by entering any Dialog
command.

Multiple Command Stacking
You can stack multiple commands on a single line by separating them with
semicolons, e.g., BEGIN 631; SELECT SPACE(W)SHUTTLE; TYPE S1/3/1.

D@ The multiple command stacking feature is not available when using DIALINDEX
(File 411) on DialogWeb and DialogLink 5.

Interrupting Command Processing

To interrupt a command that is currently processing, a BREAK character must be
transmitted. &# € On both DialogWeb and DialogL ink 5, pressing the ESC
<Escape> key will send a BREAK. On DialogLink 5, clicking the@ icon on the
toolbar will also interrupt processing.

Note: If you are accessing Dialog via a Web browser, clicking the browser’s STOP button
will interrupt data transfer but does not terminate the command execution on Dialog until
Dialog is ready to send output to you. For example, if you entered a SELECT command,
sending a BREAK would stop the execution of the command. Clicking STOP on your
browser would interrupt the command after SELECT has completed processing at the point
when it tried to display output (postings — set number, number of hits, etc. — typically
when the search is complete).




Operators

Operators

Logical Operators
OR retrieves all records that
contain at least one of the

search terms. terms.

AORB

AND retrieves all records
that contain all of the search

A AND B

NOT eliminates records that
include a search term or group
of search terms.

ANOT B

Caution: Use the NOT operator carefully. You may unintentionally eliminate relevant

records.

Proximity Operators

Symbol | Example

Function

(W) S SOLAR(W)ENERGY
S PAGO(W)PAGO

S RETINAL()SCAN

Requests that terms be adjacent to each
other and in the order specified. Can also
be used to retrieve identical terms. Empty
paired parentheses are interpreted to be the
(W) operator.

("W) | S SOLAR(BW)ENERGY

Requests that terms be within n words of
each other and in the order specified.

(N) S AIR(N)POLLUT?
S JOHNSON(N)JOHNSON

Requests that terms be adjacent but in any
order. Can also be used to retrieve
identical terms.

(nN) S SHARE(BN)MARKET

S SMOG(2N)AIR(5N)QUAL?

Requests that terms appear within a
specified “window,” in any order. For
example, SELECT A (2N) B (5N) C
retrieves records in which terms A, B, and
C appear within a 10-word window of
each other (i.e., 3 terms and 7 intervening
words = 10-word window).

(S) S SOLAR(S)HEAT

Requests that terms be in the same
subfield unit as defined by the database. In
fulltext files, requests that terms be in the
same paragraph.

L) S SOLAR(L)ENERGY

Requests that terms be in the same
descriptor unit (“pre-coordinated”) as
defined by the database (i.e., heading—
subheading entries, such as ASPIRIN—
TOXICITY).

F) S SOLAR(F)CELL?

Requests that terms be in the same field as
defined by the database.




Operators / System Features

(M) S BUTYL(T)AMINE

In chemistry databases, specifies what two
chemical segments must be present in the
same term. (T) is more restrictive than (W)
and (N) operators which may retrieve
segments appearing adjacent to one
another. For example, SELECT
BUTYL(W)AMINE retrieves
DIBUTYLAMINE, but not
TRIISOBUTYL DIALKYLAMINE.

Note: NOT proximity is also available, e.g., SELECT ECONOMIC(NOT W)RECOVERY.

Order of Execution

Parenthetical Phrase

(M, (W), (N), (S), (L), or (F)
NOT

AND
OR

Note: Using parentheses allows you to specify a different order of execution, e.g., SELECT
(SOLAR OR SUN) AND (ENERGY OR HEAT). Terms in parentheses are executed first.

System Features

Truncation

Truncation is used to permit variations in word length or spelling.
Type of Truncation | Symbol | Example

Used

Open: any number of | ? S DRIVE? retrieves DRIVER, DRIVEN, etc.
characters following S AU=ROSS E? retrieves ROSS, ERIC; ROSS,
stem. ELLEN S, etc.
Restricted: ?? S CAT? ? retrieves CAT, CATS, etc. (but not
maximum of one CATALOG).
additional character S HOUSE? ? retrieves HOUSE, HOUSES,
following stem. HOUSED, etc. (but not HOUSEHOLD).
Restricted: ?? S COMPUT?? retrieves COMPUTE, COMPUTER,
maximum number of COMPUTED, etc., (but not COMPUTATION).
additional characters S PLANT????? retrieves PLANT, PLANTS,
equal to number of PLANTING, PLANTATION (but not
guestion marks. PLANTATIONS).
Internal: allows ? S WOM?N retrieves WOMAN, WOMEN,

character replaced by
question mark to
vary; one character
replacement per
question mark.

WOMYN.

S ORGANI?ATION? retrieves ORGANISATION,
ORGANIZATION, ORGANISATIONS,
ORGANIZATIONAL, etc.

Note: Prefix truncation is only available in TRADEMARKSCAN?® databases in the TR=

field.
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Stop Words

In most databases, the following words cannot be SELECTed as search terms; the
computer will retrieve a set with zero results. Replace stop words with proximity
operators, e.g., SELECT GONE(2W)WIND.

AN FOR THE
AND FROM TO
BY OF WITH

Reserved Words and Symbols

The following words and symbols are reserved for Dialog commands and features;
therefore, they must be enclosed in quotation marks (* ) whenever they are
SELECTed as search terms, e.g., SELECT “NOT” (1W)PROFIT, SELECT
“R2”(W)D2, or SELECT “C++".

Words Symbols
AND OR El, E2, etc. . .
FILES SELECT RL R2 etc. | - (equalssign)  :(colon)
FROM STEPS S1, S1, etc. * (asterisk) / (slash)
NOT
+ (plus sign) >< (open arrow)

Basic Index Searching

The Basic Index is an every-word index to selected parts of the record, with stop
words omitted. Suffix codes are used to restrict retrieval to Basic Index fields. The
general format for using suffix codes is shown below:

SELECT <term>/<field code>,<field code>...  Basic Index field codes are defined on
the database Bluesheet

Specific fields and codes vary according to the database; refer to the database
Bluesheet (also available online in File 415 or on our Web site) or enter HELP
FIELD n online (where n is the database number).

Some examples of restricting searches to Basic Index fields are shown below.

SELECT BUDGET?/TI Terms searched in the Title (/TI) field only.
S FORD(W)MOTOR?/CO Terms searched in the Company Name (/CO)
field only.

S (DOG OR DOGS)/DE,ID Terms searched in either the Descriptor (/DE)
or Identifier (/ID) field.

S S12/TI,LP Restricts set S12 to either the Title (/TI) or Lead
Paragraph (/LP) field.
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Caution: If a suffix code is applied to a set number that refers to a set created with the
AND or NOT logical operator, the suffix will apply to at least one, but not necessarily all,
of the terms in the set.

Note: If a suffix selected is not available in the database(s) you are searching, the search
term(s) will be searched throughout the entire Basic Index.

'ﬁDiangWeb users can click on the topic help button labeled M appears on the
Search History screen.

Additional Index Searching

The Additional Indexes include every field that is indexed using prefix codes.
From one to seven prefix codes can be searched with one SELECT command (e.g.,
SELECT RO,0ON,CO=COCA COLA). The general format for searching the
Additional Indexes is shown below:

SELECT <field code>=<term> field prefix codes are defined on
the database Bluesheet.

Specific fields and codes vary according to the database. A field may be phrase
indexed or word indexed. Phrase Indexed fields are searched using a complete
phrase with spaces and no operators. Word Indexed fields are searched using
individual words, enclosed in parentheses, with operators as needed. Refer to the
database Bluesheet for more information (see Bluesheets, page 54), or enter HELP
FIELD n online (where n is the database number). If a prefix is not supported in a
database, the result will be 0 (zero) postings. Some common Additional Index
fields and prefix codes include the following:

Prefix Code _Field Name Example

AU= Author SELECT AU=JOHNSON, R?
CO= Company Name S CO=FORD MOTOR?

CS= Corporate Source S CS=(HARVARD AND MEDIC?) !
DT= Document Type S DT=REVIEW

IN= Journal Name S IN=NEW YORK TIMES
LA= Language S LA=FRENCH

PD= Publication Date S PD=20050115 2

PY= Publication Year S PY=2005

SA= Sales S SA=5M

UD= Update S UD=9999

" When word-indexed terms are searched with a prefix code, the terms must be enclosed in parentheses.
2 The format for the Publication Date field is usually YYYYMMDD, where YYYYY represents the year,
MM the month, and DD the day. EXPAND PD= to see the index.

iy DialogWeb users can click on the topic help button labeled | Ficlds _ JOve appears on the
Search History screen.
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The CURRENT Qualifier

CURRENT is used to narrow your search to records from the most current year(s)
within a file. Include CURRENT with a BEGIN command when searching a single
file, multiple files, or any of the PAPERS categories. For example, BEGIN 16,
PAPERSCA CURRENT retrieves records added to these files during the current
calendar year plus one year back (i.e., results within the last 1-2 years). If
CURRENT is not available in one or more of the files you are searching, the entire
file(s) will be searched.

Other CURRENT options for broader applications:

CURRENT or CURRENT1 = current year + 1 back year

CURRENT2 = current year + 2 back years
CURRENT3 = current year + 3 back years
CURRENT4 = current year + 4 back years
CURRENT5 = current year + 5 back years

Enter SHOW CURRENT to verify if the CURRENT feature is operating. To
cancel the CURRENT feature, enter CURRENT CANCEL.

Note: In DIALINDEX®, the CURRENT option is not available as a search option with the
SF (SET FILES) command in DIALINDEX. It is, however, available as an option when you
exit DIALINDEX and BEGIN new files. (For example, BEGIN HITS CURRENT or
BEGIN Nn:Nn CURRENT from a ranked files (RF) command list.) See pages 27 and 46
for more information on OneSearch and DIALINDEX.

& CURRENT is not available in DialogLink 5.

Range Searching
A colon (:) is used to indicate a range of sequential entries to be retrieved in a
logical OR relationship. Several examples are shown below:

SELECT SC=4021:4036 Retrieves records with SIC codes 4021 through 4036.

SELECT PD=20050115:20050131 Retrieves records with publication dates between, and
including, 15 January 2005 and 31 January 2005.

SELECT PY=1999:2005 Retrieves records with publication years 1999 through
2005.

Note: When using an EXPAND command, it is important to SELECT a range of E numbers
using a colon so that terms are saved as actual terms, e.g., SELECT E3:E12.

Numeric Searching
The following relational operators are available for searching numeric ranges:

= equal to > greater than
< less than >= greater than or equal to
<= less than or equal to

10
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Search Examples:

SELECT SA>=100,000 Retrieves sales greater than or equal to 100,000.

SELECT EM<100 Retrieves number of employees less than 100 (does not
include 100).

SELECT 100=>EM<500 Retrieves number of employees equal to or greater than

100, but less than 500 (does not include 500).

Number values can also be represented using the following abbreviations:

K thousand eg., SELECT EM>=1K

M million e.g., SELECT TA=10M:500M

B billion e.g., SELECT SA>=15B

T trillion e.g., SELECT TA=1T

%  percent e.g., SELECT PS=4% (equivalent to SELECT PS=0.04)

Exponential notation can also be used. For example, the following are equivalent:

SELECT EV=8E-2 or SELECT EV=0.08
SELECT SM="SE+3” or SELECT SM=5E3

Note: In many databases, numeric values are rounded down to the two left-most significant
digits. For example, sales of $256,000,000 are indexed as SA=250,000,000. Check the
database Bluesheet for details.

Limit Suffixes

Limit suffixes are used in SELECT statements to restrict search terms or sets to
given criteria. Limit suffixes vary by database; check the database Bluesheet, or
enter HELP LIMIT n (where n is the number for the database) for a list of
available suffixes. The following table contains several common limit suffixes.

Limit Restriction Qualifier Example
English-language documents /[ENG SELECT URBAN(S)CRIME?/ENG
Fulltext documents /[FULLTEXT | S ELECTIONS/FULLTEXT
Major descriptor IMAJ S ART THERAPY/MAJ
Patents [PAT S TRANSISTOR?/PAT
Human subject /HUMANS S STEROIDS/HUMANS
Accession number range /nnnnnn- S S12/9289234-9467934
nnnnnn
Publication Year lyyyy S MOTOROLA/2005
lyyyy:yyyy S $2/1999:2005

You can also specify multiple limits, e.g., SELECT TRANSISTOR?/ENG,PAT. In
this case the limit restrictions require that the records must be in English and a
patent. Limit and field suffixes may both be used in the same search statement,
e.g., SELECT JOINT(W)VENTURE/TI,DE,FULLTEXT,2005

11



System Features / Output Commands

The LIMITALL command can be used to restrict all subsequent sets to given
criteria.

LIMITALL/SN Restricts subsequent sets to content of limiting set.
LIMITALL/ENG Restricts subsequent sets to English-language documents.
LIMITALL CANCEL Cancels LIMITALL restrictions.

Note: All LIMITALL commands are erased upon entering a LOGOFF or BEGIN command.

& DialogWeb users can click on the topic help button labeled that appears on the
Search History screen.

Output Commands and Options

Command Example Function
TYPE TYPE S3/5/ALL Provides continuous online display of
T T S2/3/1-10 search results. Specify set/
T S4/6,K/1-5,9 format/items. If no set number is
T S6/AU,TI/4 specified, the last set is used. If no
T S8/5 format number is specified, Format 2
T S15 is assumed. If an item range is not
T 0856789/9 specified, the first record is displayed.

T S4/8/1-2 FROM EACH | TYPE can also be used for direct
record access with a Dialog accession
number.

&3 In DialogWeb click the
button next to the set to view results.
& In DialogLink click the Links
hyperlink in the record display to view
the full record or selected fields.

DISPLAY DISPLAY S2/7/1 Displays search results one screen at a
D D S8/9/ALL time. Enter PAGE (or P) for

D S12 subsequent screens. Specify

D 9856987/5 set/format/items (can also be used with

a Dialog accession number).
& In DialogLink DISPLAY works
exactly like TYPE.

PAGE PAGE Requests the next screen (page) of an
P P EXPAND or DISPLAY. Previous
Page- Page- screens can be viewed by entering

P- P- PAGE- (or P-), but can only be entered

subsequent to viewing the first screen.

12
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Command Example Function
PRINT PRINT S3/9/ALL Requests that search results be
PR PR S1/3/1,5-15 delivered through the postal

PR S4/T1,50/1-5

PR S1/5/1-6 ADDR MYMAIL
PR S1/9/ALL ADDR MYFTP
PR S6/7

PR S2

PR 08756982/9

service or electronically (email
or ftp). Specify set/format/items.
The print statement defaults to
the last set, if a set number is not
specified; to Format 2, if a
format number is not specified;
to the first 50 records, if an item
range is not specified. PRINT
can also be used for direct record
access with a Dialog accession
number.

PRINT CANCEL
PR CANCEL
PRINT-

PR-

PRINT CANCEL P002
PRINT CANCEL ALL
PR- P143

PR-

Cancels a specified PRINT
request. A PRINT CANCEL
command must be entered
within 30 minutes of the PRINT
command. If logging back on to
cancel a PRINT request created
during a previous session, the
PRINT transaction number must
be specified. Also, be sure to log
on through the same connection
(e.g., telecommunications
network, World Wide Web,
telnet, etc.).

REPORT

REPORT S8/CO,ZP,SA/1-5
REPORT S1/CO/1-9 DELIM

Produces an online tabular
display with data from the
specified fields arranged in
columns (e.g., Company Name,
Zip Code, Sales). Specify
set/fields/items. Post-processing
formats (i.e., SYLK, DELIM,
etc.) can be specified at the end
of a REPORT command.
REPORT is database specific;
check the database Bluesheet for
availability.

REPORT
Sn/TITLES

REPORT S1/TITLES

Gathers together all pages in a
report, provides tables of
contents, and allows choice of
pages of the report to order or
display. Available in files that
contain multiple-page market
research, financial, or analysts’
reports.

13



Special Print Options

Special Print Options
Command Example Function
PRINT TITLE PRINT TITLE Adds a title to search results that are
PR TITLE PHOTOGRAPHY delivered as offline prints. Titles can
SEARCH FOR R.J. contain up to 80 characters. Semi-
SMITH colons(;) cannot be included in a title.
The PRINT TITLE command must be
PR TITLE RUNNING entered before your PRINT command.
SHOES FOR DEPT. 654 Only one PRINT TITLE command can
be used per BEGIN command; PRINT
TITLE is cancelled by the next BEGIN
command.
PRINT PRO PRINT S3/9/ALL PRO Provides output without the normally
(PRINT included search history. When PRO is
RESULTS PR S5/9/1-5 ARCHIVE used, it will suppress files searched,
ONLY) 135 PRO ADDR sets selected, PRINTS requested, and
MYMAIL FROM EACH date information for both search and
Dialog Alert results.
PORTRAIT PRINT S8/5/ALL Prints records in PORTRAIT layout.
PORT PORTRAIT Note: Can only be used with PRINT
postal delivery options.
SOLO PR S4/9/2,4 SOLO Prints each record on a new page.
PR S9/5/1-5 PORT SOLO | Prints each record in a PORTRAIT
layout and on a new page.
SEND PRINT S3/9/ALL ADDR | Sends records to an alternate address
ABEMAIL; SEND and processes the PRINT command
immediately, bypassing the 30-minute
PRINT CANCEL window. SEND
applies only to PRINT statements
entered during the current session.
SEND ALL Processes all ftp or email PRINT
requests immediately, bypassing the
30-minute PRINT CANCEL window.
PRINT QUERY | PRINT QUERY Displays PRINT commands and

PRINT QUERY DETAIL

PRINT QUERY ACTIVE

PRINT QUERY ACTIVE
DETAIL

cancellations within the last 96 hours.
Displays same as PRINT QUERY,
plus the date, time, file, and costs.
Displays a log of the PRINT
commands you have entered within the
last 30 minutes and that can still be
cancelled with the PRINT CANCEL
command.

Same as PRINT QUERY ACTIVE,
plus the date, time, file, and costs.
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Formats

Predefined Formats

Each database has a number of predefined format options. The content of each
predefined format varies, depending on the type of database. Refer to the database
Bluesheet or enter HELP FMT n online (where n is the file number) for available
format options.

o DialogWeb users can click on the topic help button labeled | Formats RT0P appears on the

Search History screen. & DialogLink 5 users can click the database name in the Help &
Information Pane to view the Bluesheet.

Examples of typical predefined formats in fulltext files are shown below:

Format Options Content Displayed
1 Dialog Accession Number
2 Full Record except Abstract
3 MEDIUM Bibliographic Citation
5 Full Record except Text
6 FREE Title
7 LONG Bibliographic Citation and Text
8 SHORT Title and Indexing
9 FULL Fulltext
K KWIC Brief excerpts of text where search terms appear

The command structure for predefined formats is:

TYPE set/format/items Example: TYPE S4/5/1-23
t S1/medium/6,3,7
DISPLAY set/format/items Example: DISPLAY S6/9/2,4
d S12/free/5
PRINT set/format/items Example: PRINT S16/5/ALL

pr S2/long/1-10

KWIC (Key Word In Context) (or K) can be used alone or with another format
option to display “windows” of text that contain your search terms, e.g., TYPE
S3/6,KWIC/ALL (displays records in Format 6, plus KWIC); DISPLAY
S11/K/1-10 (displays records in KWIC). The default size of the KWIC window is
30 words. The size of the KWIC window can be changed using the SET KWIC
command.

Note: KWIC is a database specific feature; check the database Bluesheet or enter online
HELP KWIC for availability and charges, if any. KWIC cannot be used with the PRINT
command.

User-Defined Formats

User-defined formats (UDFs) can be specified using the display codes that are
listed on the database Bluesheet. The command structure for user-defined formats
is shown below:

TYPE set/display codes/items Example: TYPE S1/AU,TI,SO/1-10
DISPLAY set/display codes/items Example: DISPLAY S4/TI,AB,DE/ALL
PRINT set/display codes/items Example: PRINT S23/CO,DN/1-50
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Alternate Addressing

A predefined format can be combined with one or more display codes, (e.g.,
TYPE S7/3,DE/1-15 or PRINT S1/6,SA,EM/ALL).

Alternate Addressing and Electronic Delivery System

Alternate addressing allows you to request that your prints be delivered to an
address other than the one assigned to your user number. Alternate delivery
methods are: email, ftp and postal mail. You must first create and store the
alternate address using the EDIT ADDRESS command.

To use the address as part of the PRINT command, append the word ADDRESS
(or ADDR) and the address serial number or name to the end of your PRINT
command, e.g.,

PRINT S3/5/ALL ADDRESS MYEMAIL Sends results to an address
stored as MYEMAIL.
PR S7/9/1-3 ADDR LIBRARYFTP1 Sends results to an address

stored as LIBRARYFTP1.

SET ADDRESS can be used in the Dialog PROFILE to store an alternate address.
While in your current search session, you can use SET ADDRESS <name> to
make an address the default. You can SET one address for each delivery method.
After you have created and SET an alternate address, you can either include the
delivery method at the end of the PRINT command (e.g., PRINT S3/9/1-10 VIA
EMAIL) or you can use a different address by appending ADDR and the other
name to the end of the PRINT command (e.g., PRINT S5/9/1-5 ADDR EDMAIL).

Creating an Alternate Address

To create a new address, enter the EDIT ADDRESS command. You can specify a
name of up to 30 characters (e.g., EDIT ADDRESS SALESDEPT) or let Dialog
prompt you for a name. Once you have finished responding to each prompt for
address data, the information you have entered will display and you will be
prompted to specify whether you want to save the address.

Specify the address name in your PRINT or ORDER command:

PRINT S1/5/ALL ADDRESS MYEMAIL
ORDER S1/I1SI ADDRESS LIBRARYFTP2

To specify that the address be used throughout your search session, use the SET
ADDRESS command (e.g., SET ADDRESS MYEMAIL).

@ on DialogWeb creating, editing and deleting an Alternate Address can be done quickly
and easily using fill-in-the-blank templates and shortcut buttons. Click on the menu bar
and click the “Address Book™ link at the bottom of the page to display and edit all saved
addresses for your account.
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Alternate Addressing

Command Example Function
PRINT VIA SET ADDRESS CEOEMAIL | Sends results to an email
EMAIL PRINT S4/9/ALL VIA address that you have set up
EMAIL prior to issuing the PRINT
statement.
PRINT S3/3/ALL ADDR Sends results to an electronic
CEOEMAIL mail address stored as
CEOEMAIL.
PRINT VIA FTP SET ADDRESS MYFTPSVR | Sends results to an email

PRINT S1/9/ALL VIA FTP

PRINT S1/FULL/ALL ADDR
CMYFTPSVR

address that you have set up
prior to issuing the PRINT
statement.

Sends results to an electronic
ftp address stored as
CMYFTPSVR.

PRINT (for Postal
Service Delivery)

SET ADDRESS MYOFFICE
PRINT S2/3/1-10

PRINT S4/TI1,DE/ALL
ADDR MYOFFICE

Sends results to a postal
address that you have set up
prior to issuing the PRINT
statement. Note: For postal
delivery, the PRINT command
is entered alone without
specifying the delivery method.
Sends results to a postal
address stored as MYOFFICE.

Note: If you store an alternate address in your Dialog PROFILE (see page 48 for more
information), you can simply enter VIA EMAIL or VIA FTP as part of your PRINT

statement.
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Dialog ERA

Dialog ERASM (Electronic Redistribution and Archiving) Service

From more than 250 Dialog databases, you can use specialized TYPE, DISPLAY,
REPORT, or PRINT options to distribute print or electronic copies of search
results to other employees or departments within your organization*, or to store
search results in an in-house system. Below is a brief definition of each command
as well as some examples of how the commands can be used.

Service agreement. The definition includes your company’s employees, divisions,

and branch offices.
* An organization is defined by the specific legal entity listed in the customer information block of our Standard
Service Agreement.

Command Example Function
COPIES n PRINT S5/9/1-5 COPIES 10 Provides from Dialog one print
COPn copy, plus 10 copies of first five

records from set S5 for postal
delivery. COPIES n is available
only with the PRINT command for
paper copies via postal delivery.

REDIST n TYPE S2/3/ALL REDIST 25 Displays online all of the results in

RED n REPORT S1/TITLES REDIST 30 | S2, and grants rights to redistribute
REPORT S3/CO,SA,ST/1-25 each record 25 times within your
RED 42 organization. One original copy is

provided from Dialog. REDIST n
can be used with the TYPE,
DISPLAY, REPORT, and PRINT

commands.
ARCHIVE n | DISPLAY S1/9/1-10 ARCHIVE Displays the first 10 records from
ARCn 50 set S1, allows you to store (e.g., on

a LAN) the results, and grants
permission for up to 50 employees
in your organization to view the
information. One original copy is
provided. ARCHIVE n can be used
with the TYPE, DISPLAY,
REPORT, and PRINT commands.

Note: When you use the REDIST n or ARCHIVE n option with the REPORT TITLES
command, you should exit the REPORT TITLES menu after each REDIST or ARCHIVE if
you are distributing only the title list. If you stay in the menu and display other format
options, each of these options will be assigned with the REDIST or ARCHIVE
designation(s) and charges.

Note: You can also use more than one ERA command. For example, PR S8/4/ALL REDIST
10 ARC 25 ADDR DEPTEMAIL prints via electronic mail ALL records from set S8, grants
rights to distribute each record 10 times within your organization and store the results,
giving 25 other employees in your organization access to the information.
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Dialog ERA / Special Commands

Tracking Records after the Initial Search

The “after-the-fact” feature allows you to record information about records you
have copied, distributed, or archived. Simply enter REDIST or ARCHIVE by itself
in any file and supply the answers to the prompted questions. This information can
also be entered on a single command line:

REDIST File n/Format n/n Items/n Copies

REDIST File n/Format n/n Items/n Copies/Accession number, Accession number
ARCHIVE File n/Format n/n Items/n Users

ARCHIVE File n/Format n/n Items/n Users/Accession number, Accession number

Note: Redistribution and archival costs will be displayed in the Dialog cost estimator, which
appears when you change files, enter LOGOFF or LOGOFF HOLD, or when you enter a
COST command. These charges will also appear on your invoice.

Available Online Help

Command Description

HELP ERA Describes the service, lists service terms and conditions,
participating databases, and which databases need accession
number entries in after-the-fact tracking and/or have additional
terms and conditions.

HELP NOERA Lists Dialog databases that do not participate in ERA.

HELP RATES n Provides the most current multiplier tables for individual databases.
Use HELP RATES to determine COPIES, REDIST, or ARCHIVE
charges before entering a transaction.

HELP TERMS n | Lists individual database terms and conditions and disclaimers.

Special Commands and Features

SORT Command

Use the SORT command to rearrange the records in the final set of your search by
specific fields, such as sales in a financial report or author in a bibliography. You
may also use SORT to order records by number of times your search terms occur
in the records. Search results are sorted according to the sort specified,
alphabetically or numerically, for fields; by term frequency for HITS. Check the
database Bluesheet to determine the SORT fields available in a given database. Up
to 100,000 records may be SORTed.

Specify set/items/sortable fields or HITS. Always use ALL as the range of items or
the set will not SORT correctly. The system SORTSs in ascending order for fields
unless “D” is used to specify descending order. If HITS is specified, the set is
sorted in descending order (most frequent occurrence of terms to least frequent).
Up to five levels of SORTed fields may be specified. SORT parameters can also
be incorporated in a PRINT command (e.g., PR S5/ALL/ST/SA,D).
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SearchSaves

Examples: SORT S1/ALL/AU,TI
SORT S2/ALL/HITS
SORT S13/ALL/SA,D
SORT S3/ALL/ST,A,CY,ASAD

i DialogWeb users can click on the topic help button labeled IEXZM that appears on the
Search History screen.

Ein DialogLink 5, click the set to sort from the Set Links Pane, then choose Tasks > Sort.
A list of sortable fields will display from which to select.

SearchSaves

You can save your strategy and execute it later by storing a temporary or
permanent SearchSave. A temporary SearchSave is stored by entering the
command SAVE TEMP and is stored for seven days at no cost. After seven days,
the Dialog system automatically deletes the temporary SearchSave. A permanent
SearchSave is stored by entering the SAVE command and is stored until you
RELEASE it. There is a small monthly fee for storing permanent SearchSaves.

Command Description
SAVE Stores the entire search strategy* entered since the last
SAVE <name> BEGIN command. Assign a name for the saved search

from 1 to 30 alphanumeric characters long (e.g., SAVE
MYSMITHSEARCH). If no name is given, a serial
number is assigned. Note: A saved strategy is stored
permanently until you RELEASE it (e.g., RELEASE
MYSMITHSEARCH).

@in DialogLink 5 a pop-up window will prompt you to
enter a name for your saved search.

SAVE TEMP Saves temporarily the entire search strategy™* since the
SAVE TEMP <name> last BEGIN command. The saved search is stored for
seven days at no cost and is automatically deleted by the
system at that time. Assign a name for the saved search
from 1 to 30 alphanumeric characters long (e.g., SAVE
TEMP LASTSEARCH). If no name is given, a serial
number is assigned.

@in DialogLink 5 a pop-up window will prompt you to
enter a name for your saved search.

Once your strategy is saved with the SAVE, SAVE TEMP, or the MAP command,
it can later be EXECUTE in the desired database. (See page 29 for more
information on the MAP command.)

*The following commands are saved in a SearchSave: SELECT, SELECT STEPS, SET,
SORT, PRINT, PRINT TITLE, REMOVE DUPLICATES, IDENTIFY DUPLICATES,
IDENTIFY DUPLICATES ONLY, and Comment Lines.
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Command

Description

EXECUTE STEPS <name>
EXS <serial number>

EXS

Example:

EXS MYSMITHSEARCH

Executes saved search strategy. Assigns a set
number for each search statement. EXS entered
alone defaults to executing the most recently
created SearchSave of the current search session.

EXECUTE <name>

EX <serial number>
Example:

EX MYSMITHSEARCH

Executes search strategy by name or serial number.
Only a final set number is assigned. EX entered
alone defaults to executing the most recently
created SearchSave of the current search session.
EX also creates one set when executing a MAPped
strategy.

EXS <name>/x-y
Example:
EXS MYSAVEDSEARCH/1-4

Executes search strategy by name or number from
command line x to command line y only. Use when
you want to execute only part of a SearchSave.
Note: Specified command lines are EXECUTEd,
not set numbers; enter RECALL <name> or <serial
number> to verify lines. DO NOT include
command lines where set numbers were used as
part of the search strategy.

EXS <serial number>/USER
<User ID number>
EXS <name>/USER XXXXX

Executes search strategy by name or serial number
that was created by Dialog user XXXXX. Note:
You must enter the word USER after the slash
mark, e.g., EXS TG102604449/USER 012345.

RECALL SAVE Displays names and serial numbers of all permanent

RECALL SAVES SearchSaves (those stored with the SAVE or MAP
command), dates entered, and number of command
lines.

RECALL TEMP Displays serial numbers and names of all temporary

RECALL TEMPS SearchSaves (those stored with the SAVE TEMP

command), dates entered, and number of lines.

RECALL <serial number>
RECALL <name>

Recalls specific SearchSave by name or serial
number. Displays all commands and comment lines,

Examples: without executing the search strategy.
RECALL MYSMITHSEARCH

RECALL TG102604449

RELEASE <serial number> Releases SearchSave by name or serial number
RELEASE <name> from the system. Once released, the SearchSave
Examples: cannot be RECALLed or EXECUTEd.

RELEASE S1102604449
RELEASE MYSMITHSEARCH

*<comment>
Example:
*Search for RCN

Stores an informative comment line in your
SearchSave by entering an asterisk in place of a
command, followed by a comment line of up to 80
characters. The comment line will be stored in the
SearchSave and will display in a RECALL of the
strategy.
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EXPLODE / Duplicate Detection

EXPLODE (!) & Online Thesauri

Several Dialog databases include a thesaurus—a dictionary of subject headings—as
part of the online file. To view an online thesaurus, enter the EXPAND command
followed by a search term. If thesaurus terms are available in the database, an extra
column will appear in the EXPAND display. This extra column is labeled RT (for
Related Terms). Thesaurus terms in the EXPAND display will have a number in
the RT column that indicates the number of related terms that are available.

The EXPLODE feature works in files that have an online thesaurus with narrower
terms. Appending the EXPLODE operator (1), an exclamation point, to a valid
thesaurus term will result in retrieval of narrower terms. For example, the
statement SELECT DEMENTIA! in MEDLINE® will retrieve narrower (i.e., more
specific terms) such as ALZHEIMER DISEASE, CREUTZFELDT-JAKOB
SYNDROME, etc. Whether narrower terms include only the next level or all lower
levels depends on the database. Enter HELP THESAURI online for a list of
databases with thesauri; HELP EXPLODE for more information on the EXPLODE
feature.

Duplicate Detection

The duplicate detection feature provides a means of identifying duplicate citations
when searching one or more bibliographic files. A set of unique records, minus the
duplicates, can be obtained by using the REMOVE DUPLICATES command. In
addition, the IDENTIFY DUPLICATES and IDENTIFY DUPLICATES ONLY
commands can be used to group together duplicate records, in appropriate
alphabetical order. A maximum of 5,000 items can be applied to duplicate
detection commands. Enter HELP DUP online to display a list of files in which
duplicate detection is not offered.

Command Description

REMOVE DUPLICATES Sn Removes duplicate records and creates a set of unique
RD Sn records in which only one copy from each set of
Example: RD S3 duplicates is retained. The record retained is

determined by the file order in the last BEGIN or SET
FILES command. If no set number is specified, the
command will operate on the last set SELECTed.
IDENTIFY DUPLICATES Sn | Creates a sorted set in which duplicates are identified

ID Sn by alphabetically grouping together records with the

Example: ID S3 same title. If no set is specified, the command will
operate on the last set SELECTed.

IDENTIFY DUPLICATES Creates a set that contains only the records that are

ONLY identified as duplicates. This command can be used to

IDO Sn verify that the records have been correctly identified

Example: IDO S3 as duplicates. If no set is specified, the command will

operate on the last set SELECTed.
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Duplicate Detection

Command Description

SET FILES <file list> Allows rearranging of the order in which files will be
searched for duplicate detection. Only the files
specified with the BEGIN command can be listed.
Note: If more files are required in the search, use the
ADD and REPEAT commands (see page 3).

Note: Dialog identifies exact duplications. If there are any variations in the title, Dialog
treats these as unique records.

Quick Tip: Although duplicate detection commands are most commonly used to
identify and eliminate duplicates among two or more files, the feature can also be used
to locate duplicates within the same file.

Patent Duplicate Identification

Patent Duplicate Identification (abbreviated IDPAT) helps you manage
overlapping patent data when searching multiple patent files by organizing a set of
patent records into family-related groups of records with duplicates identified.
After a set has been created in a patent search, you can issue one of the following
commands to have Dialog identify patent groups and duplicates.

Command Description

IDPAT Displays a summary plus a patent group

IDPAT Sn table for a designated set number. If no set

Example: IDPAT S2 number is specified, the command will
operate on the last set SELECTed.

IDPAT SHORT Displays a summary for a designated set

IDPAT Sn SHORT number. If no set number is specified, the

Example: IDPAT S3 SHORT command will operate on the last set
SELECTed.

IDPAT FROM nnn Displays a summary plus a patent group

IDPAT Sn FROM nnn table from specified databases. If no set

IDPAT Sn SHORT FROM nnn number is specified, the command will

Example: IDPAT S3 FROM 340,351 operate on the last set SELECTed.

SET FILES nnn,nnn Changes the file order from which patents
are kept.

SHOW FILES Allows you to view file order.

HELP IDPAT Provides help notes for IDPAT.

The summary includes the count of family groups, unique patent records not part
of a group, and non-patent records contained in the set. The patent group table
identifies each unique group by a G number, indicates the number of records in
each group, the file and record numbers for primary records, and the file and
record numbers for duplicate records.
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IDPAT

IDPAT Search Example
?B 351,340,345

SYSTEM:0S - DIALOG OneSearch
File 351:Derwent WP1 1963-2005/UD,UM &UP=200545
(c) 2005 Thomson Derwent
File 340:CLAIMS(R)/US Patent 1950-05/Jul 14
(c) 2005 IFI/CLAIMS(R)
File 345:1Inpadoc/Fam.& Legal Stat 1968-2005/UD=200528
(c) 2005 EPO

Set Items Description
?S (PCR OR POLYMERASE(W)CHAIN(W)REACTION? OR DNA(W)SEQUENC?) AND
(CANCER? OR PRECANCER? OR NEOPLASM? OR CARCINO?)
26211 PCR
26781 POLYMERASE
368095 CHAIN
767238 REACTION?
17291 POLYMERASE(W)CHAIN(W)REACT ION?
123728 DNA
487259 SEQUENC?
27374 DNA(W)SEQUENC?
96964 CANCER?
1122 PRECANCER?
5727 NEOPLASM?
23281 CARCINO?
S1 8991 (PCR OR POLYMERASE(W)CHAIN(W)REACTION? OR
DNA(W)SEQUENC?)AND (CANCER? OR PRECANCER? OR NEOPLASM? OR CARCINO?)

?S S1/2005
8991 s1
1586770 PY=2005
S2 1339 S1/2005

?1DPAT

New file order will be: 345,351

Duplicates will be matched against primary file: 345

Press ENTER to accept or enter preferred primary file number.
?

New file order: 345, 351, 340
>>>File 345 Accession number 21314065 skipped ( Field too big ).
...examined 100 records (100)
...examined 100 records (200)

...complete& examining records
Processing
S3 1339 IDPAT (sorted in duplicate/non-duplicate order)

Summary:
S3 has 1339 records ordered as follows:
161 patent groups (records 1-368)
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IDPAT

971 patent records without duplicates (records 369-1339)

Group Table:

Groups Total Primary Record Duplicates Record
in Group Records Numbers Numbers
G1 30 F345 1 F351 9-28
F340 29-30
F351 2-8
G2 2 F345 31 F351 32
G3 2 F345 33 F351 34
G4 2 F351 35 F340 36
G5 2 F351 37 F340 38
G157 2 F351 359-360
G158 2 F351 361 F340 362
G159 2 F351 363 F340 364
G160 2 F340 365-366
G161 2 F340 367-368
1. Show Group Table 4. TYPE or PRINT Selected Records
2. Show Summary 5. TYPE or PRINT Primary and Non-Duplicate
Records
3. Quit

Enter an option (e.g., 4).
?5
S4 1165 IDPAT (primary/non-duplicate records only)

Press ENTER to TYPE records or enter PR to PRINT records via e-mail,
ftp or postal delivery.

?PR
Enter format number or two-character display tag(s) (e.g., Tl, PA) or
enter Q to return to command mode.

?T1,PA

Enter record(s) to be PRINTed (e.g., ALL or a range to receive a
desired number of Primary/Non-duplicate records, e.g., 1-10), or
enter Q to return to command mode.

?1-10

Enter alternate address name or press ENTER for default address.

?
Default address will be used

P024: PRINT 4/T1,PA/1-10 (Tl PA) estimated cost of $34.30
Estimated postal surcharge ($0.10 per record per copy) is $1.00.

Summary:
S3 has 1339 records ordered as follows:
161 patent groups (records 1-368)
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RANK

971 patent records without duplicates (records 369-1339)

1. Show Group Table 4. TYPE or PRINT Selected Records

2. Show Summary 5. TYPE or PRINT Primary and Non-Duplicate
Records

3. Quit

Enter an option (e.g., 4).
?3

RANK and VIEW Commands

The RANK command provides the ability to perform trend or statistical analysis
on an existing search set. The Dialog system extracts terms from the specified
field(s) in a set of records and lists them in ranked order, with the most highly
posted term appearing first. To use this command, simply enter RANK and the
desired field(s) (e.g., RANK PA). Each ranked term is also assigned a “rank
number” that can be used to save a term for later use or to display desired records
with the VIEW command while in the RANK menu.

To view records from RANK, enter VIEW followed by RANK number, format,
and item(s) to display (e.g., VIEW 2/9/ALL). RANK can be used in OneSearch or
in a single database.

& Note: The VIEW Command functions differently in DialogLink 5. Consult the
DialogLink 5 User Guide or online help for more information.

Once a term is ranked, a list showing the top eight terms appears on your screen in
a format that allows you to browse throughout the entire listing. Display of the
RANK list may be customized using the Options menu. For quick ranking of
search terms, you can bypass the menus and enter any or all of the following
options in a single command line, e.g., ?RANK PA S2/ALL ALPHA CONT
DETAIL.

ALPHA Lists results in alphabetical order rather than in
ranked order

CONT Provides continuous output of ranked terms

DETAIL Includes additional information in a more detailed
display

DESC Gives results in descending order rather than in ranked
order—use with numeric data

PERCENT Includes a percentage column with the basic results

When CONT, DESC, and/or ALPHA are designated, you will be prompted to
choose how many terms (e.g., only the top 50) to display. All of these options are
also available as part of the prompted menu choices that display when you enter a
basic RANK command (e.g., RANK DE).
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RANK

You can rank multiple fields with similar data (e.g., RANK DE,ID), as well as
partial fields, by placing the field code and the number of characters in
parentheses. For example, to rank only the first four characters of the International
Patent Classification Code, enter RANK (IC 1-4).

The RANK command has been designed to work in most phrase-indexed
Additional Index fields, most numeric Additional Index fields, and the phrase-
indexed Descriptor (DE) and Identifier (ID) Basic Index fields. Plus, RANK works
with all MAP fields. The RANK command does not work in any word-indexed
fields; this minimizes the retrieval of inappropriate data.

A maximum of 50,000 terms can be ranked. This means that if there is only one
term in the desired field per record, you can RANK up to 50,000 records.
However, in many databases there are multiple terms in a field; therefore, the
number of records you are able to RANK is likely to be much less than 50,000.

For additional information on RANK, enter HELP RANK online.

@ DialogLink 5 also offers the VISUAL RANK (VR) Command, a graphical version of
RANK.

RANK Search Example

[File 9] Business & Industry(R) Jul/1994-2005/Aug 22
(c) 2005 The Gale Group. All rights reserved.

?s (biometric? and security)/ti,lp
1621  BIOMETRIC?/TI,LP
40268  SECURITY/TI,LP
S1 678 S (BIOMETRIC? AND SECURITY)/TI,LP

?rank co
Started processing RANK
Processing 100 of 678 records
Processing 200 of 678 records
Processing 300 of 678 records
Processing 400 of 678 records
Processing 500 of 678 records
Processing 600 of 678 records
Completed Ranking 678 records
DIALOG RANK Results
RANK: S1/1-678 Field: CO= File(s): 9
(Rank fields found in 430 records -- 367 unique terms) Page 1 of 46
RANK No. ltems Term
1 28 IDENTIX INC
2 24  PRECISE BIOMETRICS AB
3 14 INTERNATIONAL BUSINESS MACHINES CORP
4 12 VISIONICS CORP
5 8  AUTHENTEC INC
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RANK

6 8  BIOSCRYPT INC
7 8  KEYWARE TECHNOLOGIES NV
8 7  NOVELL INC
P = next page Pn = Jump to page n
P- = previous page M = More Options Exit = Leave RANK

To view records from RANK, enter VIEW followed by RANK number,
format, and item(s) to display, e.g., VIEW 2/9/ALL.
Enter desired option(s) or enter RANK number(s) to save terms.

?m

RANK Options:

ALPHA =  Alphabetize results (T)ITLE = Add a title

DESC = Descending results (C)OMBINE = Merge results

CONT = Continuous display (V)IEW = Display records (V 1/3/1-5)
DETAIL = Detailed display CLEAR = Clear saved term(s)

PERCENT = Include percentages EXIT = Leave RANK

"x" = Display terms starting with x (where x is up to

46 alpha-numeric characters); quotes must be used,
e.g.,"IBMC" (Use RANK to return to full RANK display)

Enter desired option(s) or enter RANK number(s) to save terms.

?percent

DIALOG RANK Results

RANK: S1/1-678 Field: CO= File(s): 9

(Rank fields found in 430 records -- 367 unique terms) Page 1 of 46
RANK No. Items %Ranked Term

1 28 06.5% IDENTIX INC
2 24 05.6% PRECISE BIOMETRICS AB
3 14 03.3% INTERNATIONAL BUSINESS MACHINES CORP
4 12 02.8% VISIONICS CORP
5 8 01.9% AUTHENTEC INC
6 8 01.9% BIOSCRYPT INC
7 8 01.9% KEYWARE TECHNOLOGIES NV
8 7 01.6% NOVELL INC
P = next page Pn = Jump to page n
P- = previous page M = More Options Exit = Leave RANK

To view records from RANK, enter VIEW followed by RANK number,
format, and item(s) to display, e.g., VIEW 2/9/ALL.
Enter desired option(s) or enter RANK number(s) to save terms.

?v 2/3/1-2
--RANK 2 ITEM 1 --

03731324 Supplier Number: 134925724 (USE FORMAT 7 OR 9 FOR
FULLTEXT)

Precise Biometrics AB acquires Logware Sweden AB.

Nordic Business Report, p NA

August 08, 2005

DOCUMENT TYPE: Journal; News Brief (United Kingdom)

LANGUAGE: English RECORD TYPE: Fulltext

WORD COUNT: 187
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--RANK 2 ITEM 2 --

03694671 Supplier Number: 133652715 (USE FORMAT 7 OR 9 FOR
FULLTEXT)

Precise Biometrics AB signs 3-year business agreement with IRIS
Corporation in Malaysia.

Nordic Business Report, p NA

June 29, 2005

DOCUMENT TYPE: Journal; News Brief (United Kingdom)

LANGUAGE: English RECORD TYPE: Fulltext

WORD COUNT: 137

?exit
RANK results will be erased; have you saved all the terms of
interest? (YES/NO)

?y
Exiting... (no terms were saved)

MAP Command

The MAP command creates a SearchSave using the data extracted from a specified
field(s) in a set of records. The SearchSave can then be executed in the same or
different database(s). The MAP command is followed by a field label (e.g., MAP
DN). Alternatively, once a set is created, enter MAP alone to use the feature
through menus. MAP is a database-specific feature; check for availability in the
printed Bluesheet, online in File 415, or by entering HELP MAP n online. Some
databases offer unique field specifications that combine the terms of two or more
fields for ease of MAPping (e.g., SYRN).

Examples: MAP
MAP PN
MAP SYRN TEMP
MAP PA TEMP STEPS

MAP <field specification> TEMP creates a temporary SearchSave of extracted
data. The STEPS qualifier groups extracted data into separate search statements, so
results appear in separate sets.

@ In addition to the MAP command, a graphical interface to using the MAP command is
available in DialogLink 5. From the Set Links pane click the set number you wish to MAP,
then select Tasks > MAP.
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MAP Command Example

File 398: Chemsearch 1957-2005/Jul
(c) 2005 Amer.Chem.Soc. All rights reserved.

Set Items Description
?s lipitor
S1 10 LIPITOR

?map syrn t

1 Select Statement(s), 10 Search Term(s)
Serial#TC037

[File 154] MEDLINE(R) 1990-2005/Aug W3
(c) format only 2005 Dialog. All rights reserved.

?exs

EXS: S ATORVASTATIN()CALCIUM + ATORVASTATINQHEMICALCIUM +
ATORVASTATINQHEMICALCIUMQSALT + CI1(Q981 + LIPITOR + SORTIS + TAHOR
+ YM()548 + RN=134523-03-8 + RN=334757-04-9

1729  ATORVASTATIN
214390 CALCIUM
22 ATORVASTATIN(W)CALCIUM
1729  ATORVASTATIN
3 HEMICALCIUM
0  ATORVASTATIN(W)HEMICALCIUM
1729  ATORVASTATIN
3 HEMICALCIUM
38254  SALT
0  ATORVASTATIN(W)HEMICALCIUM(W)SALT
258177 ClI
866 981
5  CI(W)981
54  LIPITOR
4 SORTIS
0  TAHOR
967 M
1722 548
0  YM(W)548
0 RN=134523-03-8
0 RN=334757-04-9
s1 82 S ATORVASTATIN()CALCIUM + ATORVASTATIN()HEMICALCIUM +

ATORVASTATINQOHEMICALCIUMQOSALT + CI()981 + LIPITOR + SORTIS + TAHOR
+ YM()548 + RN=134523-03-8 + RN=334757-04-9
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KEEP Command

Use the KEEP command to gather selected records into a special set called SO (set
zero). The KEEP set (S0) may be used like any other set with commands such as
SELECT, SORT, TYPE, etc.

To create set SO, enter KEEP followed by a set number, a set number and record
number(s), or an accession number.

KEEP S4 Places all of the records from set S4 into set SO

KEEP S3/5,7 Places records 5,7 from set S3 into set SO

KEEP 456789 Places the record with accession number 456789 into set SO
Command Description
KEEP Places specified records in a special set zero
K Sn/items (S0). Specify set number and/or records or

K <accession number>

accession number. Set SO is cancelled by a
BEGIN, LOGOFF, KEEP-, or ORDER
command.

KEEP CANCEL Deletes set SO when used alone. Specify
KEEP- accession number to delete a specific item from
K- set SO (remaining records are kept), e.g., KEEP-
0123456
OneSearch®

OneSearch allows you to search more than one database and enter your search
term(s) once to search all files chosen. Use the BEGIN command to open one or
more databases. To open additional databases after a BEGIN command, use ADD

(see page 3).

Command

Description

SET BANNERS OFF
SET BANNERS ON

Turns off file banner display.
Turns on file banner display; ON is the system default.

BEGIN 516,531

BEGIN 16,148,610
BEGIN BIOBUS

BEGIN PAPERSNY, 16
BEGIN SCITECH NOT 33
BEGIN PAPERS
CURRENT

Connects to the specified databases. You can specify up
to 60 databases in a single BEGIN command. You can
also specify a DIALINDEX/OneSearch category. Use
the NOT logical operator to eliminate files from a
category. Include CURRENT with BEGIN to search
only the latest information (see page 10 for more on
CURRENT).

ADD 9
ADD PHARMIND,990

Adds one or more files to an in-process session.

SET DETAIL ON
SET DETAIL OFF

Displays record counts, in response to a SELECT,
EXPAND, or DISPLAY SETS command for each
database specified in the last BEGIN command. Cancel
by entering SET DETAIL OFF.
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Command

Description

SHOW FILES

Displays the file banner(s) for the databases you are
currently searching.

SORT <PD or PY>

Allows you to SORT your OneSearch search results by
either Publication Date (PD) or Publication Year (PY);
this option is available only in files that offer the
Publication Date or Year field (check the printed
Bluesheet, File 415, or enter HELP SORT n online).

Note: PD or PY (when present in a file) are the only SORT codes that can be used when
searching multiple files (i.e., a OneSearch session). All other SORT codes must specify the

file number.

FROM Qualifier

The FROM qualifier is designed especially for OneSearch. One or more file
numbers, separated by commas, can follow FROM. FROM is also available for
use in a OneSearch session; it is used with the TYPE, DISPLAY, or PRINT
command to request output from each of the files in a OneSearch session. The
FROM option must be the last element of your output command.

Command Example

EXPAND EXPAND CO=AKAMAI FROM 16
EXPAND JN=TIME FROM 47

SELECT SELECT MYTHOLOGY FROM 88,190

DISPLAY SETS
DS

DISPLAY SETS FROM 16
DS FROM 634,640
DS FROM EACH

TYPE

TYPE S1/9/1-3 FROM EACH

DISPLAY<individual
sets>
DISPLAY <records>

DISPLAY S1 FROM 16
DISPLAY S1/5/1-6 FROM 47

PRINT

PRINT S2/5/ALL FROM 51
PRINT S1/5/1-3 SOLO FROM 16,9
PRINT S2/5/1 ADDR MYEMAIL FROM EACH

KEEP

KEEP S5/1-6,8 FROM 640
KEEP 03964292 FROM 155

The FROM option is required with the SORT commands when used in a
OneSearch to SORT by a field other than PY (Publication Year) or PD
(Publication Date). For example, SORT S1/ALL/AU FROM 148.
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Document Delivery Services

Dialog offers millions of fulltext documents online in its databases; however,
customers may wish to obtain copies of certain documents in their original
published formats. Several service options are available from Dialog for this
purpose.

Dialog SourceOne

Dialog SourceOne is available from most Dialog products. The service provides
high-quality digitized images of patents delivered via email from Thomson Patent
Store. Other documents can be delivered via ftp, postal mail, express mail, or
email. The patent collection includes the United States, European (EPO) and
World Intellectual Property (WIPO/PCT) patent publications. Enter ORDER
while connected to the Dialog service to bring up an order menu for Dialog
SourceOne.

& To access Dialog SourceOne from DialogWeb, click &= (order) on the menu bar.

@ To access Dialog SourceOne from DialogLink 4 or 5, click <= (shopping cart) on the
menu bar.

ORDER
Orders for copies of documents may be placed online using the ORDER
command. Document suppliers are identified by an acronym up to 8 characters.

Command Description

ORDER ISI Orders items listed in set SO from supplier

oISl acronym, e.g., ORDER ISI. May be followed by
additional characters indicating special
instructions (A total of 240 characters can be
entered.)

ORDER ISl ADDRESS Axxxx Specifies that ordered documents be sent to an

ORDER ISl ADDR AXXXXX alternate address. The EDIT ADDRESS
command is used to create an alternate address;
see page 48.

ORDER set number/items aaaa Orders items from a specified set number from

O set number/items ISl supplier acronoym (aaaa), e.g., ORDER
S8/1/1,6,9 ISI.

ORDER ITEM aaaa XxX... Orders from supplier aaaa a specific item, which

OITEM xxX... is described in special instructions xxx....

O 1 1S] xxx Following the supplier name. Up to 240
characters are allowed; do not use semicolons.

ORDER CANCEL Rnnn Deletes order Rnnn. Must be entered prior to the

ORDER- Rnnnn retrieval of the order by the supplier. A range of

O- Rnnnn orders can be specified with a hyphen or colon.

O- Rnnn-Rnnn

O- Rnnn:Rnnn
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Command Description

ORDER LIST ... Displays list of orders placed and their status.

O L NEW Variations: O L OLD, O L Rnnn, O L DATE

OLIST... yyyymmdd, O L ALL, ORDER LIST ALL is

OL... the default.

ORDER REVIEW. .. Displays items in any order, including the title,

OREVIEW. .. author, and source. Variations: O R NEW, O R

OR... OLD, ORRnnnn, O R ALL. ORDER
REVIEW ALL is the default.

Dialog eLinks

Dialog provides additional value to its vast scientific, technical, and medical
collection by enabling searchers to link to the fulltext of articles from many of our
leading databases. These hyperlinks, or “Dialog eLinks,” are available by separate
arrangement with the publisher or other electronic document aggregator. Dialog
has partnered with over 100 publishers and aggregators to provide access to the
fulltext of more than 11,000 journals. In addition, Dialog has created an easy-to-
use subscription management tool that allows Dialog account administrators to
easily set up and manage their eLinking service. For more information on Dialog
eLinks, contact your account representative or the Knowledge Center. Dialog
eLinks are available in DialogWeb and DialogLink 5 and other Web-based
interfaces from Dialog.

Dialog Alert Service

Dialog Alert is a current awareness service that allows a search to run
automatically whenever new records are added to the database and have the results
delivered electronically, via ftp, email, or postal mail. The Alert service is
available for most regularly updated databases on the Dialog and DataStar
services. The exact method for creating an Alert differs depending on the
particular product being used. For immediate assistance in setting up an Alert, use
the online Customer Alerts Bureau order form (support.dialog.com/alerts), or
contact the Knowledge Center (U.S.) at 1-800-334-2564.

The procedure for creating, modifying, and deleting an Alert using Dialog Classic
is illustrated below.

Note: ERA commands can be used in an Alert profile; see page 18 for information on using
the ERA service and PRINT command.

Creating a Dialog Alert Profile

Follow the steps below (see example below):

1. BEGIN in an appropriate database or in multiple databases. (Refer to the
Database Catalog or enter HELP ALERT online to identify databases that
offer the Dialog Alert service.)
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2. Enter your SELECT statements and complete your search strategy.

3. Enter the SAVE ALERT command. You can follow the command with an
optional 1 to 30 character name (e.g., SAVE ALERT NEWS).

4. Follow the prompts to schedule when the Alert will run and to set
deduplication and notification options. Review the Alert settings and save the
Alert when prompted.

Note: Many databases allow you to choose the frequency with which your search will be
run, such as Daily, Weekly, Monthly or when the database updates. Enter HELP RATES n
(where n is the file number) for frequency options.

@ In DialogLink 5, view the frequency options by clicking the database name in the Help
and Information pane and selecting Rates from the drop-down menu.

Enter a PRINT command to identify the set of records to be delivered each time
the Dialog Alert profile is run. The results will be mailed to you by first class mail,
unless you specify an alternate address. See page 16 for alternate address
information. If you entered one or more print statements before typing SAVE
ALERT, the Dialog system will prompt you to cancel your PRINT statements if
current records are not desired.

Other commands used with the Dialog Alert feature:

Command Example Function

RECALL ALERT Displays a list of your Dialog
Alert profiles. Includes the
name or serial number, date and
time entered, number of
command lines, and frequency.
RECALL <name> RECALL NEWSALERT Displays the entire Dialog Alert
strategy (including command
and comment lines), without
executing the Dialog Alert
profile.
RELEASE <name> | RELEASE NEWSALERT Releases the specified Dialog
Alert profile from the system.
Once RELEASEC, the profile
cannot be EXECUTEd or
RECALLed.
EDIT <name> EDIT NEWSALERT Allows you to edit the specified
Dialog Alert profile by using
the Online Editor (see page 48).
Note: The RECALL and RELEASE commands can be entered from any database. You can
store the strategy with the SAVE ALERT command from any database, using the FROM
command; you can also EDIT a profile in any file, but you must remember to save it using
the FROM command, e.g., SAVE ALERT NEWS DAILY FROM 16.
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Quick Tip: A Dialog Alert profile can also be used as a SearchSave, i.e., you can
execute it in other databases or share it with other Dialog customers (e.g., EXS
DAGEOM/USER 54321).

o DialogWeb users have the option to click the Alerts button and use a fill-in-the-blanks
template to set up a Dialog Alert.

@in DialogLink 5, the SAVE ALERT command will call up a fill-in-the-blanks template
to set up a Dialog Alert. Using the DialogLink 5 Report feature, you may create a “Custom
E-Mail Alert” to control the layout and data elements included in your Alert, as well as to
add a hyperlinked table of contents. See page 55 for more about DialogLink.

Dialog Alert Example
File 154:MEDLINE(R) 1990-2005/Jul W3
(c) format only 2005 The Dialog Corp.

Set Items Description
?S OSTEOARTHRITIS(L)CO
15124 OSTEOARTHRITIS/DE
587468 CO/DE
S1 1275 OSTEOARTHRITIS(L)CO

?SAVE ALERT MEDICAL WEEK
Do you want the Alert run based on a file"s Alert Update schedule or
on a Custom schedule you set up? U=Update C=Custom Q=Quit H=Help

?C

Choose the day of week you want the Alert to run:

1. Monday

2. Tuesday

3. Wednesday

4. Thursday

5. Friday

6. Saturday

7. Sunday Q=Quit H=Help
?1

Enter exact hour to run the Alert (e.g, 2pm or 14) Q=Quit H=Help
?8AM

Do you want duplicates removed automatically? Y=Yes N=No H=Help
?Y

Do you want notification even if no documents are found? Y=Yes N=No
?N

Your alert currently has these settings:

1. Databases: 154

2. Frequency: Weekly

3. Run at: Monday at 8AM

4. Dedupe: Y

5. Notify: ONLY when new documents are found (Notify=0FF)
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To make a change, enter a line number.

To save the Alert, enter S for Save. Q=Quit H=Help
?S

Enter 1 to 30 characters for a name. Q=Quit H=Help
?MEDICAL

Enter a PRINT statement for your Alert. Q=Quit H=Help
?PR S1/9/ALL

Enter the next PRINT command or enter S to SAVE. Q=Quit H=Help
?S

Alert "MEDICAL" saved

?RECALL MEDICAL
Alert name: MEDICAL

Databases: 154

Modified: 18jul05

Frequency: Weekly on Monday

Run: 8AM

Dedupe: Y

Notify: ONLY when new documents are found (Notify=0FF)

Line Commands:

1. S OSTEOARTHRITIS

2. S S1/2005

3. PRINT TITLE MEDICAL
4. PR S1/9/ALL

Note: To view an address, enter RECALL ADDRESS <name>.

Dialog Table of Contents Alerts

Table of Contents Alerts from Dialog automatically sends a list of article titles
from publications you select—directly to your email address. You can then order
the complete text of articles in a reply email by checking off the titles of interest.
Contact Dialog for more information.

o DialogWeb users can click the Alerts button from the menu bar and use a drop-down
menu to choose publications of interest to set up a Table of Contents Alert.

Database Finding Tools

DIALINDEX®

File 411, DIALINDEX, is a central index for most of the Dialog databases. In
DIALINDEX, you can compare the number of records retrieved by your strategy
among a group of databases. File 411 is divided into subject categories and
SuperCategories. The acronyms for the SuperCategories are listed on page 40. Any
combination of file names or category names may be specified with the SET
FILES (SF) command.

Note: In DIALINDEX, sets are not created. The TYPE, DISPLAY, and PRINT commands
are invalid in DIALINDEX. You must BEGIN the appropriate database(s) and execute your
search to obtain search output.
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BEGIN 411 B 411 Connects to File 411, DIALINDEX
BEGIN DIALINDEX

SET FILES <file list> | SF INTLCO, Specifies the databases you wish to

SET FILES <file list>
SF <file list>

INTLNEWS, 148

SF PAPERS NOT 631
SF ALLBUSINESS
SF ALL

scan. Enter the category acronym(s),
file number(s), or a combination,
separated by commas. You can also
use NOT to remove files from a
category. The databases you select
with the SF command constitute
your File List. When searching in
DIALINDEX, you must select at
least two databases.

SHOW FILES

SHOW FILES

Displays the banners for the files in
your File List.

SELECT <search
term(s)>

S DISCRIM?
S (AGE)
(S)DISCRIM?

S POL(W)POT/TI,LP
S AU=(LEE R? OR
LEE, R?)

Allows you to see the number of
records available for search terms in
your chosen database(s) by entering
a single search statement (2000-
character maximum). Your search
can consist of a single term, a
multiple-word phrase, or any
appropriate suffix-coded or prefix-
coded terms. Nested terminology,
proximity operators, and truncated
terms can also be used. After
entering your SELECT statement,
the system scans the databases and
displays the number of records in
each file. Files that do not retrieve
any records do not display unless
you have SET DETAIL ON.

SELECT

SELECT

Enter SELECT by itself to repeat the
last SELECT statement in a new
group of files (SET FILES) in
DIALINDEX.

EXPAND <terms
or indexes>
E <terms or indexes>

EXPAND
ADOLESCENT
E CO=INTEL

Allows you to scan subject terms or
index entries to verify what is
present in up to 100 files. SET
DETAIL ON shows the file number
and number of records in that file.
Since sets are not created in
DIALINDEX, no E numbers are
displayed in DIALINDEX.
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Command

Example

Description

RANK FILES

RANK FILES

Used to reorganize the list of databases that has
been scanned. Displays a ranked list of files and
items (numbered N1, N2, etc.) with those that
retrieved the most records for your strategy at
the top of the list. You can BEGIN a OneSearch
search of up to 60 of these files by using the N
numbers, file numbers, or by entering BEGIN
HITS.

BEGIN HITS

BEGIN HITS

Allows you to BEGIN up to 60 of the files from
your DIALINDEX search in which “hits” were
found. If there are more than 60 files in your
DIALINDEX search, the first 60 files in which
hits are found will be the files opened by
BEGIN HITS.

Note: CURRENT is not available in File 411.

Quick Tip: You can store your strategy in DIALINDEX with the SAVE or SAVE
TEMP command. After beginning in the files of your choice, use the EXS (EXECUTE
STEPS) command to run the saved strategy in one or more databases. You can also
stack the EXS command with the BEGIN command, using a semicolon(;), to have the
SaveSearch strategy automatically executed. For example, after entering SAVE or
SAVE TEMP, use the RANK FILES command, then enter BEGIN N1:N5;EXS or enter
BEGIN HITS;EXS (or BEGIN HITS;EXS TG102427811).

(%] DialogWeb offers searchers the Databases Selection Tool in addition to DIALINDEX.
Databases are arranged by topic and users can click through the topics to identify relevant

databases.

@in DialogLink 5 a graphical interface to DIALINDEX appears automatically when you
type BEGIN 411. Consult the DialogLink 5 User Guide or the DialogLink 5 online help for

more information.

DIALINDEX/OneSearch Subject Categories

Used with the SF command in File 411 or with a OneSearch BEGIN command.
More than one category can be listed (OneSearch currently has a 60 file per search
limitation); specific file numbers can also be used:

SF NEWSWIRE, PAPERS

BEGIN PAPERS
BEGIN POLLUT 47,211

The content of each subject category can be displayed by entering HELP
<category name>, e.g., HELP ENERGY. Subject category names are also listed in
the Dialog Database Catalog.
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DIALINDEX® SuperCategories

Used with the SET FILES (SF) command in File 411 only; these are not available

as OneSearch categories.

ALL (All subjects)

ALLAGRI (Agriculture)

ALLBIOSCI (Biosciences)
ALLBUSINESS (Business)
ALLCHEM (Chemistry)
ALLCHEMH (Chemical Handbooks)
ALLCODIR (Company Directories)
ALLCOFIN (Company Financials & Reports)
ALLCOMMON (Common Law Marks)
ALLENERGY (Energy)

ALLENG (Engineering)

ALLENVIR (Environment)
ALLGOVER (Government)
ALLHUMAN (Humanities)
ALLINDMK (Industries and Markets)
ALLIP (Intellectual Property)
ALLMATER (Materials)

ALLMEDPH (Medicine and
Pharmaceuticals)

ALLNEWS (News)

ALLONTAP (ONTAP Files)

ALLPAPER (Newspapers—Fulltext)

ALLPAT (Patents)

ALLPATFU (Patents—Fulltext)

ALLPHYS (Physics, Astronomy and
Mathematics Research)

ALLPRODUCTS (Products)

ALLREFERENCE (Reference)

ALLSCIENCE (Science)

ALLSOC (Social Sciences)

ALLSOCHU (Social Sciences and
Humanities)

ALLTMKS (Trademarks)

Note: The ALLONTAPS category can also be used in File 290, ONTAP DIALINDEX.

Dialog Finder Files

The Dialog Finder Files are databases that have been created to aid you in
selecting databases that contain just the information you are looking for. The
Finder Files have been designed to allow you to search multiple database indexes

with common search elements.

Dialog Company Name Finder™

The Dialog Company Name Finder (File 416) is designed to help you locate
Dialog files where company information can be found. Company name records are
created from all entries in the company name indexes of the Dialog files included
in File 416. (Enter HELP NEWS 416 for a complete list of databases included in
File 416.) Company names are shown in the form in which they appear in the
original database index, including abbreviations, punctuation (commas and periods
are stripped out), and spelling variations. The names are limited to 46 characters,
the maximum length of an index entry; longer names are truncated.

Use File 416 for quick identification of files that have information pertaining to a
particular company. When the exact name is unknown, EXPAND in the CO=
index to browse company name variations. Keywords in the company name can be

searched in the Basic Index.

Once a set is created, a preformatted REPORT, which includes company name,
record type, file number, and number of occurrences, is available for this file; enter
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REPORT Sn/COMPANY. The information in the report will be sorted and
displayed in a numbered listing from which you can select desired entries. Once
you have selected a number(s), the system will automatically save the terms, exit
File 416, BEGIN the files that have the selected information, and EXECUTE the
saved terms.

Dialog Journal Name Finder™

The Dialog Journal Name Finder (File 414 or JRNLFIND) is the master index to
journal names contained in Dialog databases. (Refer to HELP NEWS 414 for a list
of files included in File 414.) Individual records have been created from all entries
in the JN= index of the Dialog files included in File 414. Journal names are
included in the form in which they appear in the original database index, including
abbreviations, punctuation, and spelling variations. The names are limited to 46
characters, the maximum length of an index entry; longer names are truncated.

Use File 414 to quickly identify Dialog files that have the most comprehensive
coverage of a journal. When the exact name is unknown, EXPAND in the JN=
index on a keyword from the title to browse journal name variations. Keywords in
the journal name can also be selected; truncate to include various name endings.

Once a set is created, a preformatted REPORT, which includes journal name,
record type, file number, and number of occurrences, is available for this file; enter
REPORT Sn/JOURNAL. The information in the report will be sorted

and displayed in a numbered listing from which you can select desired entries.
Once you have selected a number(s), the system will automatically save the terms,
exit File 414, BEGIN the files that have the selected information, and EXECUTE
the saved terms.

Dialog Product Code Finder™

Dialog Product Code Finder (File 413 or PRODFIND) is designed to locate
product information in Dialog databases. Records are created from all entries in
the Additional Indexes that reference product names and product codes of the
Dialog files that are included in File 413. (Refer to HELP NEWS 413 for a
complete list of files included in File 413.)

Product names are shown in the form in which they appear in the original database
index, including abbreviations, punctuation (commas and periods are stripped out),
and spelling variations. The names are limited to 46 characters, the maximum
length of an index entry; longer names are truncated. If a database has multiple
Additional Indexes that reference product information—e.g., both Product Name
(PN=) and Product Code (PC=)—separate records are created in File 413 for each
index.
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Use File 413 to quickly identify files that contain product information and the
appropriate codes to use for searching. When the exact name is unknown,
EXPAND in the PN= index on a keyword from the name to browse product name
variations. Keywords from the product names can also be selected; truncate to
include various name endings.

Once a set is created, a preformatted REPORT, which includes product name,
record type, file number, and number of occurrences, is available for this file; enter
REPORT Sn/PRODUCT. The information in the report will be sorted and
displayed in a numbered listing from which you can select desired entries. Once
you have selected a number(s), the system will automatically save the terms, exit
File 413, BEGIN the files that have the selected information, and EXECUTE the
saved terms.

Sample Search from Dialog Journal Name Finder™
?begin 414

File 414:Dialog Journal Name Finder(TM) 2005/Jul
(c) 2005 The Dialog Corp.

Set Items Description

?expand jn=natural science

Ref Items Index-term

El 1 JIN=NATURAL SCIENC // MEMOIRS OF THE EHIME UNIVERS

E2 1 JIN=NATURAL SCIENC // PROCEEDINGS OF THE INSTITUTE

E3 3 *IN=NATURAL SCIENCE

E4 1 JIN=NATURAL SCIENCE // ARCHAEOLOGY AND

E5 1 JIN=NATURAL SCIENCE // COLLECTED PAPERS ON

E6 1 JIN=NATURAL SCIENCE // DIRASAT

E7 1 JIN=NATURAL SCIENCE // DONGGUK JOURNAL OF

E8 1 JIN=NATURAL SCIENCE // ECOLOGICAL BULLETINS SWEDIS

E9 2 JIN=NATURAL SCIENCE // FUDAN JOURNAL

E10 2 JN=NATURAL SCIENCE // INDIAN JOURNAL OF PHYSICAL

E11 1 JIN=NATURAL SCIENCE // JOURNAL OF

E12 1 JIN=NATURAL SCIENCE // JOURNAL OF CHENGDU UNIVERSI
Enter P or PAGE for more

?s e3

S1 3  JIN="NATURAL SCIENCE*
?REPORT S1/JOURNAL
DIALOG(R)File 414 :Dialog Journal Name Finder(T™M)
(c) 2005 The Dialog Corp. All rts. reserv.
3 Journals Available
Journal File Number Type Record Count

1 NATURAL SCIENCE 10 BIBLIOGRAPHIC 73
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2 NATURAL SCIENCE 11 BIBLIOGRAPHIC
3 NATURAL SCIENCE 144 BIBLIOGRAPHIC

Enter item number(s), P for next page, or EXIT to end Report:
?1

Selected item(s): 1
Items from file(s): 10

Enter YES to save items and begin searching these Tfiles,
P for next page, or EXIT to end Report:
?yes

Temp SearchSave "TD491" stored
1 Select Statement, 1 Search Term(s)
SearchSave TD491

1 SearchSave(s), 1 Search Term(s)
Leaving Report/JOURNAL. ..

File 10:AGRICOLA 70-2005/Jul
(c) format only 2005 The Dialog Corporation

Set Items Description

S1 73 JIN="NATURAL SCIENCE"

SET Commands

SET commands can be stored in your PROFILE or can be entered any time during your
current search session. All SET commands used in your current search session (with the
exception of SET PASSWORD) remain in effect until LOGOFF or until modified or

cancelled by another SET command. For more information on ERA, see Dialog ERA on

page 18.

Note: SET options that are available in DialogWeb are flagged with the k] symbol. SET

options that are available in DialogLink 5 are flagged with the €& symbol. In DialogLink 5,

many SET options may also be configured as part of Searcher Preferences under
Configuration > Settings on the menu bar.

Command Description

the address for each PRINT command.

(KX

SET ADDRESS XXXXXXXX Specifies that prints or orders be sent to the stored
address. You can have a different address stored
Example: SET ADDR MYMAIL | in your PROFILE for email, ftp and postal mail. If
you use SET ADDRESS prior to entering more
than one print request, it is not necessary to verify
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Command

Description

SET ALIAS <alias text> <real
text>

SET ALIAS <alias text> OFF
SET ALIAS <alias text> ON

Examples:

SET ALIAS ADJ (W)
SET ALIAS

SET ALIAS ADJ OFF
SET ALIAS ADJ ON

Sets up an alias you choose for Dialog search
commands, operators, search terms, or database
numbers. The alias must be a single alpha-
numeric word, up to 15 characters in length.
Entering SET ALIAS alone will prompt you to
enter the correct information. SET ALIAS <alias
text> OFF will suspend the alias until it is set ON.

oe (also may be configured in DialogLink 5
Searcher Preferences)

SET BANNERS ON
SET BANNERS OFF

Turns on or off the display of the file banners
when BEGINning two or more files; a single
generic banner displays for all of the files. ON is
the system default. &

SET BANNERS SHORT
SET BANNERS LONG

Set to SHORT, displays a one-line banner per
database. LONG, the system default setting,
displays all available banner information. @

SET CONNECT ON
SET CONNECT OFF

Changes the method of calculating usage charges
to connect time; use SET CONNECT OFF to reset
to the default DialUnits. SET CONNECT ON

may be specified only in your PROFILE (see page
48). SET CONNECT OFF may be entered at any
time during your search session. @ (may be
configured in DialogLink 5 Searcher Preferences).

SET COST OFF
SET COST ON

Set to OFF, shows cost display consisting only of
date. Set to ON restores cost display. @ (may be
configured in DialogLink 5 Searcher Preferences)

SET COST SHORT
SET COST LONG

Set to SHORT, cost display shows estimate for
current file(s) and estimated total costs. Output
charges are not separately displayed. To restore
full cost display, enter SET COST LONG, the
system default. &

SET COST ONESEARCH

Sets OneSearch session cost display to a single
notation; also SET COST ONE. &

SET DETAIL ON

Used in DIALINDEX and OneSearch, displays
record counts for individual files. Cancel with

SET DETAIL OFF, the system default. &

SET FILESn,n,n ...
Example: SET FILES 8,6,16

Sets the file order in DIALINDEX; changes the
file order in OneSearch—used with duplicate

detection commands. % ®

SET Hnn
SET H 63

Sets horizontal line length (maximum of 132).
System default is 75 Y ) (may be configured in
DialogLink 5 Searcher Preferences as “Line
Length™).
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Command Description

SET HILIGHT ON Enables highlighting of search terms in output if
SET HI ON set ON. Cancel with SET HILIGHT OFF, the
SET HILIGHT OFF system default. & € (may be configured in
SET HI OFF

DialogLink 5 Searcher Preferences).

SET HILIGHT <characters>
SET HI <characters>

Specifies highlighting by displaying extra
characters around your search terms in output.
You may use up to five characters for your
highlight. For example, enter SET HI %*% to
designate the %*% symbols as the highlighting
characters.

SET KWICn
SETKn
Example: SET K 50

Sets size of KWIC window (i.e., number of words
around the search term(s) that are displayed when
the KWIC format is used). Maximum window
size is 50 words. System default is 30 words. o
@ (may be configured in DialogLink 5 Searcher
Preferences)

SET NOTICE ON

SET NOTICE <amount>

Example: SET NOTICE 50
SET NOTICE $1

Initiates notification of costs that will be incurred
by output commands (such as TYPE or PRINT).
If you issue the SET NOTICE ON command, the
default cost notification is $100. SET NOTICE
OFF turns off the notification. You can also
designate the cost at which notification is issued;
valid cost amounts are from $0.01 up. Use of the

dollar sign is optional. o0 (may be configured
in DialogLink 5 Searcher Preferences)

SET PASSWORD <real> <alias>

Examples:

SET PASSWORD ABCD1234
DEMO

SET PASSWORD ABCD1234
SET PASSWORD

Defines an alias password. You must specify your
real Dialog password, followed by an alias that
you wish to set (must be 3-8 characters). To
cancel the alias, enter SET PASSWORD <real>,
where <real> is your real Dialog password. If
SET PASSWORD is entered alone, you will be
prompted to supply the correct information. Do
not use this in your PROFILE. & When SET
using DialogWeb, there is a 24-hour delay for the
password alias change to take effect. @ on
DialogLink 5 a fill-in-the-blanks window appears
when SET PASSWORD is entered.

SET POSTINGS ON
SET POSTINGS OFF

Displays the number of postings (total occur-
rences) of search terms. System default is OFF. @
(may be configured in DialogLink 5 Searcher
Preferences)

SET SCREEN hh vv
Example: SET SCREEN 80 42

Sets characters per line (hh) and lines per screen
(vv) for search output. System defaults are H=72;

V=20, &
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Command

Description

SET SELECT SHORT
SET SELECT FULL

Suppresses the intermediate search results in
response to the SELECT command. Use SET
SELECT FULL to restore full display. System
default is FULL.

SET SUBACCOUNT <name>

Examples: SET SUBACCT 515.6
(Jones)

Assigns a user-defined subaccount (up to 32
characters) for billing purposes. SET
SUBACCOUNT <name> applies to current
search session. SET SUBACCT? can be entered
as the last line in your PROFILE to establish a
prompt each time you log on to enter a
subaccount.

SET SUBACCT BACK <name>
SET SUBACCT ?

SET SUBACCT BACK ?

SET SUBACCT BACK MATH
DEPT

SET SUBACCT BACK <name> applies to costs
since last BEGIN command or since logon if
BEGIN has not yet been entered. SET SUBACCT
BACK ? can be entered as the last line in your
PROFILE to establish a prompt each time you log

on to enter a subaccount. ' @ (may be
configured in DialogLink 5 Searcher Preferences)

SET Un XX,xX, . ..
Example: SET U1 CO,DN

TYPE S5/U1/ALL
DISPLAY S3/U2/1-10
PRINT S6/U1/5,8

Sets a user-defined format for up to nine formats
(U1-U9) containing specified display codes for
use during a search session (or store the SET Un
command in your PROFILE; see page 48). Also
displays the cost of the user-defined format. Note:
The per-record cost defaults to the least expensive
predefined format that contains all of the
requested field codes.

Use your custom formats with the TYPE,
DISPLAY, or PRINT command:

Displays records in user-defined Format U1.
Displays records in user-defined Format U2.
Prints offline records in user-defined Format U1.
o0 Not available in DialogLink 5; however,
user-defined formats may be configured in
DialogLink 5 Searcher Preferences as part of
ALIAS settings, or by using the SET ALIAS
command.

SETVnn
Example: SET V 36
SETVO

Sets number of lines per screen to nn. SET V 0 is
commonly entered before REPORT command to

allow a continuous display. )
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SHOW Command

Use the SHOW command to display any SET parameters that are currently in
effect. You can display all of the SET parameters by entering SHOW ALL. You
can also specify just the parameter of interest.

Command Description

SHOW <parameter> Displays the settings for specific SET

Examples: parameters.

SHOW FILES Displays the file banner(s) for files you are
currently searching.

SHOW ALL Displays the status of all SET parameters.

SHOW HI Displays the status of the HILIGHT parameter.

SHOW Un Displays the field labels defined with the
specified User Defined Format Un

PROFILE Feature

The Dialog PROFILE feature allows you to customize the Dialog service to

your own needs. Any of the SET commands listed on the previous pages can be
stored in your PROFILE, except SET PASSWORD (your alias password is stored
indefinitely until you change or cancel it). After storing one or more SET
commands in your PROFILE, the SET commands will be executed automatically
each time you log on and will remain in effect for the duration of your search
session.

Creating Your PROFILE

To create your PROFILE, follow the steps below (this can be done in any data-

base):

1. Enter EDIT to establish your Dialog PROFILE. If you have already created a
PROFILE, enter EDIT PROFILE to modify your PROFILE.

2. Enter your first SET command and press ENTER; you will be prompted to input the
next line of your PROFILE at the INPUT: prompt.

3. Enter additional SET commands at each INPUT: prompt. If you are entering a SET
SUBACCT command, it must appear as the last line of your PROFILE. When you are
finished entering SET commands, press ENTER twice at the INPUT: prompt to return to
Edit Mode.

4. Enter SAVE PROFILE at the EDIT: prompt. Your PROFILE is stored and will be
automatically activated each time you log on.

Note: If you want to use the SET command(s) you have just stored in your PROFILE, you
must log off and log back on.
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Command Example Function
Viewing your PROFILE | RECALL PROFILE Displays your current PROFILE.
Editing your PROFILE EDIT PROFILE Places you in the Online Editor.

You can make changes to your
existing PROFILE by using any of
the Online Editor commands (see
below).

Releasing your
PROFILE

RELEASE PROFILE | Cancels your PROFILE and

restores system defaults.

& In DialogLink 5, the settings contained in the PROFILE are stored in Searcher
Preferences. See the DialogLink 5 User Guide for more information.

Online Editor

You can create or edit SearchSaves, Dialog Alert profiles, alternate addresses, or
your Dialog PROFILE using the Online Editor. The Online Editor can be used
in any database, except Dialog HomeBase. When saving a Dialog Alert profile
in a database other than the one it will run in, be sure to use the FROM option

to designate the correct file.

Command

Description

EDIT

Creates your PROFILE, a new SearchSave, or a Dialog
Alert profile.

EDIT <name or number>
Examples:

EDIT COMPINT
EDIT PATENTWATCH

Edits an existing SearchSave, Alert profile, address, or
PROFILE; enter EDIT followed by the desired name or
serial number.

Edits an existing SearchSave named COMPINT.

Edits an existing Alert profile named
PATENTWATCH.

EDIT ADDRESS
EDIT ADDR FTP
EDIT EMAIL
EDIT POSTAL
EDIT FTP

Creates an alternate address to use with the PRINT
and/or ORDER commands. You will be prompted to
enter address information.

EDIT ADDRESS
<name or number>

Modifies a previously stored address; enter EDIT
ADDR followed by the desired name or serial number.

Example:

EDIT ADDRESS MYMAIL

EDIT PROFILE Modifies your previously stored PROFILE.
RECALL ADDRESS Displays names and serial numbers of all addresses
RECALL POSTAL stored, date and time entered, command lines, and
RECALL EMAIL delivery method. Specific delivery addresses can also
RECALL FTP be displayed.
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Command Description
RECALL <name or number> | Displays a specific SearchSave, Alert profile, address,
Example: or PROFILE by its name or number.

RECALL MYMAIL

RELEASE <name or
number>

Example: RELEASE
MYMAIL

Deletes a stored SearchSave, Alert profile, address, or
PROFILE from the system. Once released, the
SearchSave, Alert profile, address, or PROFILE cannot
be RECALLed.

Note: Before RELEASEing an address, be sure that it is not included in any Dialog Alert

profiles.

Commands Entered at the EDIT: Prompt:

Command Description

LIST Displays all current lines of text while in the

L Editor; lines are numbered in increments of
10 (unless RENUM is used).

INSERT Allows you to add lines to the existing text

| by placing you in Input Mode. To return to
Edit Mode, press ENTER at the INPUT:
prompt to send a blank line.

INSERT nn Allows you to insert a new line at line nn of

I nn existing text, e.g., INSERT 21 places you in

Input Mode immediately after Line 20.

CHANGE <line #>/old/new/
C

Examples:

CHANGE 30/CBS/NBC/

C 50.S S9/DE.S S8/DE.

Permits you to change “old text” to “new
text” in the specified line.

Note: If text contains a slash mark (/), use
periods (.) to separate old and new text.

COPY <line #> to <line #>CO
Example: COPY 100 TO 255

Permits you to duplicate the specified line
number to an additional location.

DELETE <line #>
DELETE <line #>-<line #>
DELETE ALL

D

Example: DELETE 30

Allows you to delete specified line
number(s).

Note: Use caution when deleting line
numbers. The deleted line (or set) may have
been used in other lines of your strategy.
These embedded set numbers are not
renumbered after a change or deletion.

MOVE <line #> to <line #>>
M
Example: MOVE 50 TO 75

Allows you to move the specified line
number to a different location.

RENUM
RENUM n

Permits you to renumber lines by 10s unless
otherwise specified. For example, RENUM 5
renumbers lines in increments of 5.
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Command Description

QUIT Allows you to leave the editor without saving
any changes.

Note: The Online Editor does not
automatically change set numbers; if

your strategy uses set numbers in its
command lines, you must adjust the set
numbers by using the CHANGE command.

SAVE PROFILE Permits you to save your Dialog PROFILE
along with any changes.

SAVE Permits you to store the appropriate alternate

SAVE ADDRESS address, Dialog Alert profile, or SearchSave,

SAVE ALERT along with any changes. When editing any of

Examples: SAVE ADDR MJONES these through the same connection, you will

SAVE ALERT JET be prompted to replace the old one (yes or
no).

Online Editor Example for SearchSave

?edit bookstoresearch
Editor entered

Name: BOOKSTORESEARCH
Total lines: 5

Line increment: 10
Last line: 50

EDIT:

?list

10. SELECT ENGLAND/DE,TI

20. SELECT BOOKSTORE? OR BOOK(W)STORE?
30. S S2/T1,DE

40. S S1 AND S3

50. SELECT S4 AND MYSTERY

EDIT:
?delete 30

EDIT:

?insert 21

INPUT: 21

?select science(w)fiction
INPUT: 22

?<ENTER>

Returning to EDIT mode
EDIT:

?change 40/s3/s2 and s3/
40. S S1 AND S2 AND S3

EDIT:
?delete 50
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EDIT:

?list

10. SELECT ENGLAND/DE,TI

20. SELECT BOOKSTORE? OR BOOK(W)STORE?
21. SELECT SCIENCE(W)FICTION

40. S S1 AND S2 AND S3

EDIT:

?renum

Name: BOOKSTORESEARCH
Total lines: 4

Line increment: 10
Last line: 40

EDIT:

?list

10. SELECT ENGLAND/DE,TI

20. SELECT BOOKSTORE? OR BOOK(W)STORE?
30. SELECT SCIENCE(W)FICTION

40. S S1 AND S2 AND S3

EDIT:
?save
—>Replace “BOOKSTORESEARCH”? (yes/no)

?y
Search-save “SABOOK” stored
Exit from editor

Online Editor
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Dialog Knowledge Center
Personal assistance is available from the Dialog Knowledge Center 24 hours per day,
Monday through Friday, at

Telephone 1800 334 2564 within North America
00 800 33 34 25 64 outside North America
1919 468 9890 (Fax)

Email dialogcustomer@thomson.com

support.dialog.com

The Dialog online support Web site (support.dialog.com) contains links to help on
a variety of topics from product descriptions to pricing. Extensive search
assistance documentation is also available there, as are links to training materials
and tutorials.

KnowledgeBase

KnowledgeBase is a searchable repository of answers that offers instant access to
frequently asked questions (FAQs), search solutions, technical support, search tips,
and online assistance. KnowledgeBase is available 24 hours a day, seven days a
week via the Web at support.dialog.com, on the Dialog service as File 418.

Help Online

Help messages are also available online at any time during your search by using
the HELP command. For example, entering the command HELP PRINT displays a
help message explaining the use of the PRINT command. To view a complete
listing of all online HELP commands, enter HELP HELP. Some of the more
frequently used HELP commands include:

HELP FIELD n To display a complete list of searchable fields for database n.
Example: HELP FIELD 16

HELP FILE n To display a description of database n.
Example: HELP FILE 519

HELP FMTn To display available format options for database n.
Example: HELP FMT 635

HELP LIMITn To display a list of limit qualifiers for database n.
Example: HELP LIMIT 6

HELP RATESn To display a complete rate schedule for database n.

Example: HELP RATES 631

The HELP command can be abbreviated as a question mark. For example, enter
?RATES 154 to display the rates for File 154. A summary of the estimated cost of
your search displays each time you enter a BEGIN or LOGOFF command; to
check your costs during a search session, simply enter the command COST.
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& For online help, DialogWeb or DialogLink 5 users can click on the HELP button on the
menu bar. In DialogWeb help is also available by clicking & (question mark in a red circle)
next to the Command box, or the topic help buttons (Rates, Limits, Formats, etc.) that
appear on the Search History screen.

Training Options

Dialog offers a variety of training options including public training classes, self-
paced online courses, Web-delivered interactive training classes, personalized
telephone training, and a broad array of product support documentation. Training
schedules and materials may be found online at support.dialog.com/training.

ONTAP Databases

Practice online is available at free or minimal cost. A collection of specially-
created databases are available for training and practice. To use these ONTAP
(ONline Training And Practice) databases at no charge, you must log on using a
current ONTAP User ID and password. Current ONTAP User IDs and passwords
may be found at training.dialog.com/sem_info/ontap_pw, or by contacting the
Knowledge Center.

Account Administration

Questions or requests concerning your Dialog account may be communicated to
the Knowledge Center or to your account representative directly. In addition, you
may use the online “Account Maintenance Aids” at support.dialog.com/account/
for specific administrative requests, for example: account activation or de-
activation, password requests, invoice questions, to request billing by email, etc.

Pricing

Dialog offers many pricing options, including annual subscription-based pricing as
well as transactional pricing. In addition, many individual databases are available
at a fixed annual subscription price through the Dialog Choice plan. For more
information, contact your account representative or the Dialog Knowledge Center.

Current transactional pricing information for all Dialog products and services is
available online at support.dialog.com/pricing. To check costs during a search
session, enter the command COST. Check pricing for specific databases with
HELP RATES n. Database rates are also part of the Bluesheets online (see
Database Documentation, below). Check terms of usage for specific database with
HELP TERMS n.

@ DialogLink (all versions) includes an accounting feature that will track online usage
automatically. Tabular reports may be generated from this data to enable further analysis or
processing, such as for internal chargeback purposes. For more information, consult the
DialogLink User Guide.
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Database Documentation

The Dialog Database Catalog contains a brief description of each database
available on the Dialog service. Additional information includes: provider name,
database language, geographic coverage, database number(s), update frequency,
years of coverage, and special features. Access the Dialog Database Catalog
online at support.dialog.com/publications/dbcat/.

The most comprehensive information on a specific database is available in Dialog
Bluesheets. Each Bluesheet includes details on the subject scope, organization,
and indexing features of each database. Additional database-specific
documentation, such as subject heading or code lists, is available via hyperlinks.
Access the Bluesheets online at library.dialog.com/bluesheets/.

& The Bluesheet for open database(s) are available by clicking on the Search
History screen, or the database name whenever it appears as a hyperlink.

@ The Bluesheet(s) for open database(s) are available by clicking the database name in the
DialogLink 5 Help and Information Pane, or by selecting Help > Bluesheets from the menu
bar.

Newsletters

Dialog strives to keep its customers informed of the latest system enhancements
and content additions via its electronic newsletters. E-newsletters are available for
specific communities of interest, such as Patents or Chemistry, as well as a
general-interest What’s New. Specialized e-newsletters are also available for
training announcements, Quantum?, and the Graduate Education Program. Sign up
for e-newsletters at www.dialog.com/contacts/mailinglists.

Custom Solutions

In addition to off-the-shelf user interfaces, such as DialogWeb and Dialog Classic,
Dialog offers customized solutions for accessing Dialog content. Using a suite of
specialized products and services, Dialog can help you integrate business-critical
content from Dialog into corporate intranets, extranets or portal environments. For
more information, contact your account representative or the Dialog Knowledge
Center.

Connecting to Dialog

Internet Access

You can access the Dialog service through the Internet via telnet, via the
DialogWeb or DialogClassic Web sites, or via DialogLink software. Secure access
is available for DialogWeb and DialogClassic Web by using the https:// protocol
https://www.dialogweb.com and https://www.dialogclassic.com.

¢ DialogLink 5 software includes a configuration option for secure access.
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Telnet
To access Dialog by telnet, you must be an existing Dialog customer and have
a current Dialog User ID and password. Telnet sessions use telnet software that
you must have installed on your local machine or network, and properly
configured in your browser’s “helper applications” or similar feature. You may
need to talk with your local provider or systems administrator about configuring or
installing telnet software. The Dialog telnet address is dialog.com. If using an
Internet browser, the most common format for starting a Dialog telnet session
would be to enter the URL as: telnet://dialog.com.
When connecting to Dialog via the telnet link, follow these simple steps:

1. Enter your Dialog Customer User ID at the prompt.

2. Enter your Dialog Password at the prompt.

DialogWeb and DialogClassic Web

To login to Dialog through DialogWeb (www.dialogweb.com) or DialogClassic
Web, (www.dialogclassic.com) go to the URL for the product, and enter your
Dialog Customer User ID and Password in the boxes provided.

DialogLink®

DialogLink is a free communications software package for the Windows®
operating system which offers enhanced access to the Dialog and DataStar
services. The Command Language covered in previous sections works in
DialogLink, with many enhancements and streamlined features. Major features of
DialogLink 5 are described in this section. For additional information about
DialogLink 5, or to download the software, go to support.dialog.com/dialoglink.

The Session Window
The DialogLink 5 Session window has two work areas: the Retrieve Buffer and
the Type-Ahead Buffer.

The upper section of the window, the Retrieve Buffer, displays all online
interactions — your search commands and the system responses.

The Type-Ahead Buffer, in the lower section of the window, has four tabbed
options: Command, Previous, Reports and Chemical Structure. The Type-
Ahead Buffer allows you to enter and edit your search before going online and to
type search commands at your own pace while connected.

The Session window also contains the following:

e A Toolbar at the top of the Session window provides buttons for standard
Windows operations, as well as buttons for the DialogLink 5 features such as
displaying and marking text and ordering documents. DialogLink-specific
icons include:
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« Stop (View > Stop) @ Click to stop processing a command at the
next logical breakpoint.
o Log Off/Log On Click to log off ™= or log on =, to Dialog.
e A Linking Pane with sections for Help and Information, Set Links and Session
Navigator displays on the right side of the Session window.
e  Connection status information appears at the bottom of the Session window.

U fiatopt ik 5.0 - [Disleg Session]
) Fle £ vem Seweon Corfmeoion Wedies te

Toolbar —plHEd R A=d0mOrE

2| Halp and Infor mation

Retrieve __| > =
Buffer Bidmben

Linking |
Pane

Type'Ahead Comenind [ Frivious | Regorts | Chemical Sctue

Buffer > g
Status e =
Indicator Vistart, [ 3vewinethe [0 seevmms, [kt [ o pet | b gt 5w BT

Links in DialogLink 5
Links to a number of Dialog commands can be found in the Linking Pane on the
right side of the Session window under

Set Links. Set Links A
Task Links are always a choice in the Pickist
Set Links pane and present Dialog ;wtk

- - - anl
commands via a graphical interface. A P - 3
Tasks drop-down box provides a list of Dipkates ¢ ERRGDRDALE )
Dialog operations that are commonly Fa e
applied to sets, such as sorting the set, SaveTemp o
removing duplicates, saving searches,
etc.

Record Links appear at the top of each record in the Retrieve Buffer. Clicking the
Links link presents a menu of actions including displaying records, ordering
documents or extending the search by taking terms from your selected record and
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using them as search terms in another Dialog database or in DIALINDEX. The
Links choices vary from database to database.

Configuring DialogLink

The Configuration menu allows you to manage searchers and their associated
User IDs, Preferences, Clients and Projects, and to change system defaults for
display and file storage.

Use the Configuration > Settings menu to:

e Add, Edit and Delete searchers from the Searchers, Projects and Clients
window by clicking the appropriate button.

o  Set Preferences for each searcher by clicking the Preferences button to define
Set options for a Searcher. (See page 43 for more on SET Command options)

e Assign multiple Project/Client definitions to track searcher activity by Project,
Client, Charge Code or Job.

Visual Commands

Some Dialog commands use task windows, checkbox selection and clickable
buttons to simplify the functionality. In all cases, the new versions of familiar
commands produce essentially the same results as in the Classic Dialog interface.
Several entirely new commands have been created specifically for DialogLink 5:
VISUAL EXPAND and VISUAL RANK.

e VISUAL EXPAND (VE) provides a 25-item Expand list of terms in a
separate window. Examples: VE DE; VISUAL EXPAND AU (See page 4
for more on EXPAND)

e VISUAL RANK (VRANK or VR), available from the Set Links pane, lets
you select Rank from the Tasks drop-down menu. A window opens so you
can choose from a list of available Rank fields. Examples: VR DE; VRANK
AU (See page 26 for more on RANK)

DialogLink Output and Post-Processing Features

Several new output options are available in DialogLink 5 that enable you to save
search results in text, RTF, XML, HTML, Adobe® Acrobat® PDF, Microsoft®
Word and Excel formats.

PICKLIST Command

The PICKLIST command displays records from your search set in a separate
window and adds a checkbox next to each record. Point-and-click options are
included in the PICKLIST window for saving, viewing, printing and displaying
additional records from the set.

57



DialogLink

Examples: PICKLIST S1/FULL/1-10
PICK S10/3/1-10 FROM 340, 351
PICK S2/6/1-2 FROM EACH
Note: The Picklist is also available from the Set Links pane by clicking the set you want to
view.

Marked Text

The Mark function lets you select content in the Retrieve Buffer. The selection is
automatically copied and pasted into the Marked Text window. Text in the Marked
Text window may be annotated and saved in a variety of formats including: plain
text (TXT), Microsoft® Word (DOC), Rich Text Format (RTF), Adobe® Acrobat®
Portable Document Format (PDF), and HTML.

Click the Mark icon = in the DialogLink toolbar; or

Select Edit > Mark from the menu; or

Type the keyboard shortcut Ctrl+M; or

Right-click the highlighted text and choose Mark from the options list.

e To shift between the Mark window and the Session window, click “ or click
Window > Dialog Session to return focus to the Session window.

Downloading Records to XML, HTML and TEXT Files

Enter the XML, HTML or TEXT command, followed by the set number, the
format and the record number(s) of the item(s) you want to download to save your
search results. Then, use the VIEW command to open the file.

Examples: XML S1/9/1-3, 6
TEXT S3/3/1 COPIES 25
HTML S2/SHORT/1-5

Note: The VIEW command displays the contents of the Download directory. Highlight a
file name and click Open to view the contents of the file.

Creating Reports
The Reports Tab in the DialogLink Type-Ahead Buffer is used to create
customized Microsoft® Word or Microsoft® Excel reports from your search results.

Command | Previo | gpemical Sructre |

el Reports ‘Word Reports
This faatre croay® o TRt creanir f-rvl'@' Roport This fsature croates & Mcrosofii Creat Report
Excel report from Diakg data - 4| word report from Diakg data - :
dowmioaced n L. Craate Templsts | | downioaded in v Craate Templam
Edit Tamplate Edit Tempiate
Get Templates - " | Get Ternplates :

To produce a report you need:
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e An XML file of search results. Use the XML command to create your results

file (e.g., xml s1/9/1-10).
e An Excel or Word report template. A template controls the content and

appearance of the finished report. You can download templates or create your
own using the Get Template and Create Template functions available from

the Reports tab. (Consult the DialogLink User Guide or DialogLink Help
menu for more details on creating your own template.)

To generate the finished report from the XML results file and the template, use the

Create Report function in the Reports tab.

Get Template provides Excel and Word templates in different subject categories
created by Dialog experts. To create a report using Get Template:
o  Click the Reports tab, and Get Template for Word or Excel.

Cornrmand ] Previous Reports lChemicaI Structure ]
Excel Templates

E W Eiomedical and Pharma Templates Wigw

+-[JIntellectual Property Templates oad

+-[JBusiness and News Templatas Dales
OHelp with DialogLink Reports Back

< >

e Click the + sign to see individual templates under each category
o  Check the template of choice and click view Or _ Dowrlaad
to save the template

o Click Create Report to open the template and select the file with the data for

your report

Word and Excel Report Commands

Command Example Description

WORD <XML file WORD biomed WORD creates a Microsoft®
name> USING WORD/ | USING Word report using data you stored
<template name>* WORD/medline using the XML command and a

template you created using the
Word > Create Template option
under the Reports Tab.

EXCEL < XML file EXCEL finance EXCEL creates a Microsoft®
name> USING EXCEL/ | USING Excel report using data you stored
<template name>* EXCEL/week 1 using the XML command and a

template you created using the
Excel > Create Template option
under the Reports tab.

Note: Do not include the .xml or .xslt file type specifications in the command.
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Chemical Structure Searching

DialogLink 5 allows you to conduct chemical structure searches using a chemical
structure drawing program, or directly using chemical structure drawing files (with
.MOL extensions). You can restrict your search to an exact match or find larger
structures that include the structure you entered. Check the DialogLink 5 User
Guide for more details about Chemical Structure Searching.

An example of a Chemical Structure Search using a drawing program is shown
below. You must configure a drawing program in DialogLink 5 in order to use this
feature. You may also perform a chemical structure search using commands
without a drawing program if you have a drawing file (MOL extension). The CSS
command is used with the following syntax: CSS <filepath> AS <type of search>.
For more information on Chemical Structure Searching, consult the user guide or
online help in DialogLink 5.

Sample Chemical Structure Search

B DiatogLink 5.0 - [Dialog Session] 8] x]
(¥ File Edit View Session Configuration Window Help - =] x|
bAH =% ala N, B0 v OE
B 290

[File 390] Bellstein Facts July 2004

(c) 2004 Beslstesn GrabH. All rights reserved
*Frie 390: File has been reloaded Flease see HELF NEWS 390 IMPORTANT - Frice based on output See HELP RATES 390,

|»

Heb ard Tnfiormation
Alpha Test Info & Tooks
280 Baikstein Facts Ly 200

Step 1 T

Launch Drawing
Program.

Chemical Structurs |

Laurch Brawing Frogram J§ Defire Search
Choose £53 Eollsction(s):

Chonss Search Type:
Wﬂ’e—j 300: Beilstein Facts
452: Brous Drug Data Report
Shuchre 128: PharmaProjects
928: PharmaProjects (Subseribers)
£23: Derwent Chemistry Resource [Test]

Connected 0:43 Bob - Duog - 302706 Frished: 2 69¢
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L Dlakog] ink 5.0 - [Blalog Session] =: = =5 x|
(B File Edit View Sesston Configuration Window Help = x|

- Loc] — =1olx| Help ard Infor mation
[File 390] F|E2d F: Options Object Text Templates Chemistry Window Help - =] x| Abha Tost I B Tooh
) 2004 B |
i 30 FEEEEREEEEE e e

Step 2

? Draw structure
' and copy to
clipboard to
‘ send to
. : ) DialogLink.

Lo [EEL el [+ sl < []S

Command ‘

e

|§U slrucire EI = T OERSERT T o
7 452: Prous Crug Data Repart
Struchre 1 128: DharmeProjects

" 028: PharmaProjects (Subscrbers)
0 23: Derwent Chemistry Resource [Test]

Conrecied 404 [Boh Disog - 312766 Fricho 269

I Dialop.nk 5.0 - [Diakog == =]
{F File Edit View Session Configuration Window Help _ =] %
= Ol o = 7

S4EHZA% 00N B0 B0

"I il , " 24 elp and Information

File 390] Bullstein Facts July 2004 b Tl B Tooe
¢) 2004 Beilstein GenbH Al nghts resarved A Tinlinie B Togk

300; Beikinin Facts_duby 200
*Rle 190 Ale has boen reloaded Please see HELP NEWS 190 IMPORTANT - Price based an autput Soe HELP RATES 190 N K

1] eo——] 3]
Step 3 T )

DialogLink
checks the
clipboard for Sessicn Navigator :
.MOL file. El

Cremical Syuchre |

‘Choose C55 Collection(s):
=] [0 deikten Facts
452: Prous Orug Data Report
128: Phar marojects
G Pharmarojects (Subcr bere)
823 Derwent Chemisry Resouree [Test]

Connectsd 514 |fBob - Diskog - 202706 Frished 2634
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b Db |
(6 s Kdit View Sewlon  Confipurstion Widow el

L =A% GR e s =00 . R

almral]
~IB1X|

i b= Y

Hep e b e
", D00 ImLAELA I
el 3L T - BT T
— % Step 4
. s |
* Structure is Bire
" ! uploaded and Sl ATEICTEF SFREIH B
results retrieved.
af | =
Display records S
E25 Srructura 3HA-IL-UT L1 AT.L0 M4 enl e 4 with the usual E:':-‘:u_-ﬂ For LIl Rul
: 41 wrructirm fo : ol
e s Dialog commands.
St T 1 100
L=l | |
Corerurd | Prasous | Rspert Chenicnd Snacirs |
ot cawsh
S i O Corecteny)
SAANARE =] |- 0: tadewnPaca
#33: Fraum Drug Dads Fegeri
e T PO R
T | Sha PO R (TR D
LT3 Dwrward Chaericy Paroures [T
[T T A r——— ITT]
1 METT |
i Ple Cdit WView Semrisa Configuration Windsw  Help LR

SR E AT W
5% 20Ty

Synanyes Bullvelandisschasal

Step 5
O

Click
[Edit Molecule]
to load online
screen structure
0 into drawing
package.

[ LR SRk Wi
7 Badeiee Facn b 303

ai i
oLk
Bl STRCTEF SEREVH DY

| CrerweslSinears

—E Ry — =y
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Lo D bk ) - g Umm it AT |
L.:_‘f-ll." tdli View Seminn Cosfiguraiion Widew il : a__[ﬁ]ﬂ
ZF = % i op g 11
Y B - [Linkiiked 1] == M= = TR
** I i Edit Dptions Object Terl Tomplates Ot y Window Halp ol x '.'::TZ._'.TL_.,-M
CEMEREEEREREER 5 O dehtar Facn ity XK
st IH
Step 6 RS
Further editing of .
-
the structureon [ o
screen is possible, B
O UL 15

if desired.

Al .

v 200 ok - Dl - AUTHG [Fraesd 11 1B

For more information about Chemical Structure Searching or any of the other features of
DialogLink 5, consult the DialogLink 5 User Guide, online helps, or sign up for DialogLink
training at support.dialog.com/training.
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